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This magazine was created using :

WELCOME TO ANOTHER ISSUE OF FULL CIRCLE.

B

oth Greg and Elmer return this month (for Python and LibreOffice respectively) and are
joined by John who returns with another LaTeX article. The fourth article isn't really a
HowTo, but I wanted to include it anyway so that you programmers out there can have some
fun throughout December. It's an article on advent programming. In other words; a daily
challenge from the first of December through to the 24th (Christmas Day).
This month Charles touches upon 3D printers. This is something I plan on covering from
next month onwards as I've just taken delivery of a RepRapPro Fisher 1 . This printer was
previously sold in 'beta', but now it's in v1 .0 and I'll be discussing the build and software in
the coming months.
As I write this the latest Ubuntu phone update (OTA-8) is being rolled out. This is the last
update of 201 5. The next one, OTA-9, will be due for delivery near the end of January. And
all you Russian readers will be happy to hear that the BQ E5 is now available to buy in Russia
and comes with special Russian scopes pre-installed. Enjoy!
I also have a couple of books here that I need to plough through to get reviews written
up. One is 'How Software Works', and the other is 'The Maker's Guide to the Zombie
Apocalypse'. Oh, and I also have another book review for next month too.

Find Full Circle on:
goo.gl/FRTMl

facebook.com/fullcircle
magazine
twitter.com/#!/fullcirclemag
http://issuu.com/fullcircle
magazine

All the best, and keep in touch!
Ronnie
ronnie@fullcirclemagazine.org

https://play.google.com
/store/books/author?id=
Ronnie+Tucker
http://www.magzter.com/
publishers/Full-Circle
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Submitted by Arnfried Walbrecht

SNAPPY U BUNTU 1 6.04 LTS
WILL SUPPORT N VIDIA AND
AMD D RIVERS, S AYS M ARK
SHUTTLEWORTH

Mark Shuttleworth immediately
replied that they would all be
supported in the 1 6.04 LTS release
of the operating system.

R

Source:
http://linux.softpedia.com/blog/sn
appy-ubuntu-1 6-04-lts-willsupport-nvidia-and-amd-driverssays-mark-shuttleworth495462.shtml

Well, today we have more
excellent news for all of you who
use the Snappy Ubuntu Core
operating system on embedded
and IoT devices. Mr. Shuttleworth
has stated in a recent email on the
Snappy Core mailing list that the
upcoming Ubuntu Snappy Core
1 6.04 LTS (Xenial Xerus) operating
system will support proprietary
graphics drivers.

IBM TAKES LINUX

emember when we told you,
guys, that Mark Shuttleworth,
founder of Canonical and Ubuntu
Linux, the world's most popular
free operating system, said that
Snappy Ubuntu Core 1 6.04 LTS
would support private snaps?

When asked by Dan Kegel if
Snappy Ubuntu Core has support
for high-performance OpenGL
graphics drivers, such as the
proprietary ones from Nvidia and
AMD, as well as those from Intel,

MAINFRAMES BACK TO THE
FUTURE

just a new way to access facilities
that existing IBM products offer, it
may help drive migration of x86
workloads onto IBM’s highest-end
kit.

campaigns?

Though I can't prove it (at least
not in the time I have), I believe the
main cause was "Big data: The next
frontier for innovation,
competition, and productivity",
Big Blue’s big iron already has
rich virtualisation offerings. At the published by McKinsey in May
201 1 , to much fanfare. That report,
lowest level, the PR/SM facility
and following ones by McKinsey,
splits each machine’s resources
drove publicity in Forbes, The
into multiple logical partitions
Economist, various O'Reilly pubs,
(LPARs), each appearing as a
separate machine with a portion of Financial Times and many
the host’s processing and storage others—while providing ample
sales fodder for every big vendor
capacity. Even if the machine’s
selling Big Data products and
configured as a single unit, it’s
services.
really one LPAR.

I

Among those big vendors, none
Source:
http://www.theregister.co.uk/201 5 did a better job of leveraging and
BM introduced several
generating buzz than IBM. See
significant new elements for its /1 1 /02/ibm_linux_mainframes/
Resources for the results of a
Linux server stack last month:
Google search for IBM + "Big
support for KVM on its z Systems
Data", for the calendar years
mainframes, Linux-only models in
201 0–201 1 . Note that the first
both the z Systems and Power
H
OW WILL THE B IG D ATA
publication listed in that search,
Systems ranges, and a new
C
RAZE
P
LAY
O
UT
?
"Bringing big data to the
purchasing model.
Enterprise", is dated May 1 6, 201 1 ,
hat
happened
in
201
1
?
Did
the same month as the McKinsey
The most technically interesting
Big
Data
spontaneously
report. The next, "IBM Big Data new development is mainframe
combust?
Was
there
a
campaign
of
Where do I start?" is dated
support for KVM, the Linux kernel’s
some
kind?
A
coordinated
set
of
November 23, 201 1 .
built-in hypervisor. Although this is
full circle magazine #1 03
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Source:
http://www.linuxjournal.com/cont
ent/how-will-big-data-craze-playout

M ICROSOFT AND RED H AT
REACH LINUX D EAL

M

icrosoft Corp. and Red Hat
Inc., longtime rivals from
conflicting camps of the software
industry, plan to collaborate in the
cloud.
The companies are announcing
a partnership Wednesday to make
Red Hat’s version of the Linux
operating system available to
users of Microsoft Azure, the
software company’s cloud service.
Under the deal, Microsoft
agreed to designate Red Hat’s
Linux as its “preferred” option for
enterprise-style computing jobs on
Azure. In addition, personnel from
both companies will work together
in Redmond, Wash.—Microsoft’s
hometown—to offer technical
support to customers.
No financial elements of the
deal are being disclosed.

Software like this is not illegal,
Source:
http://www.wsj.com/articles/micro mainly because it is also used by
soft-and-red-hat-reach-linux-deal- programmers and testers in their
daily jobs. RATs become illegal
1 446642000
when someone uses them for
malicious purposes.

O MNI RAT LETS H ACKERS
CONTROL ANDROID PHONES,
WINDOWS, M AC, AND LINUX
PCS

R

AT stands for Remote Access
Trojan (some use the term
Tool as well) and refers to a
particular piece of malware that
infects user computers via a client
component, which then starts
communicating with a server
counterpart. This allows an
attacker to steal data from a
target, spy on the user, and even
take control of the victim's device.
Unlike previous Android RAT
kits, OmniRAT comes with built-in
support for controlling desktops,
something that its competitors
don't have the ability to do.
Additionally, also compared to its
competition, OmniRAT is also ten
times cheaper to purchase, being
offered for sale at prices between
$25 and $50 (€23 and €46).
full circle magazine #1 03

Around mid-August this year,
Avast detected one of these
malicious campaigns in action, one
that involved a version of
OmniRAT, spreading via SMS
messages.

weaknesses that could be fixed but
haven’t been. Worse, as Internet
security has surged as a subject of
international concern, Torvalds has
engaged in an occasionally profane
standoff with experts on the
subject. One group he has
dismissed as “masturbating
monkeys.” In blasting the security
features produced by another
group, he said in a public post,
“Please just kill yourself now. The
world would be a better place.”

Source:
http://news.softpedia.com/news/o
mnirat-lets-hackers-controlandroid-phones-windows-mac-andlinux-pcs-495779.shtml

Source:
http://www.washingtonpost.com/s
f/business/201 5/1 1 /05/net-ofinsecurity-the-kernel-of-theargument/

THE KERNEL OF THE

M ENTOR G RAPHICS
ANNOUNCES CUSTOMIZABLE,
SECURE END -TO -END I OT
SOLUTION WITH I NTEGRATED
G ATEWAY, CLOUD AND EDGE
D EVICES

ARGUMENT

F

or Linux, the operating system
that Torvalds created and
named after himself, has come to
dominate the exploding online
world, making it more popular
overall than rivals from Microsoft
and Apple.
But while Linux is fast, flexible
and free, a growing chorus of
critics warn that it has security

5

M

entor Graphics Corporation
announced the availability of
its customizable edge-to-cloud IoT
solution that enables companies to
get its product to market quicker
contents ^
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while helping to reduce risk, cost,
and development cycles. The
Mentor IoT solution comprises a
unique customizable IoT gateway
System Design Kit (SysDK), a cloud
backend, and runtime solutions on
which to build an array of IoT edge
devices. It enables IoT
requirements with support from 8bit microcontrollers to 64-bit
microprocessors, and deployments
of 1 00,000+ gateways each
supporting dozens of edge
devices.
To provide customers flexibility
in meeting business needs, the
technology can be licensed
commercially as an end-to-end
solution or in parts to address and
complete a customer's existing
solution. Additionally, Mentor
Graphics can deploy and manage
the solution as a service to
customers. Both options are
available today.

LATEST TPP LEAK SHOWS

general, one provision in the
leaked document presents a
SYSTEMIC THREAT TO
particular threat to software
SOFTWARE FREEDOM
freedom. Holders of copyright,
patent, and other proprietary
n March 25th, 201 5, Wikileaks interests are now included in the
released a leaked chapter of definition of "investor." Given the
the ongoing Trans-Pacific
destructive nature of these
Partnership (TPP) negotiations, the provisions, the fact that
multinational trade agreement
proprietary developers could use
that is being developed through a them to interfere with local
series of secret negotiations and
government protections of users'
aims to create a host of new
rights is cause for alarm.
restrictions. We here at the FSF
have been fighting against TPP for
Source:
years, as it represents the threat of https://www.fsf.org/blogs/licensin
a world dominated by DRM,
g/latest-tpp-leak-shows-systemicsoftware patents, and perpetual
threat-to-software-freedom
copyright.

O

The latest leaked chapter on
investments lays out changes to a
system of supra-national courts
known extrajudicial investor-state
dispute settlement (ISDS)
tribunals. For years, these courts
have enabled large companies to
sue democratically-elected
Source:
http://www.arcweb.com/Blog/Post governments over policies that
/859/Mentor-Graphics-Announces- these corporations oppose. For
Customizable,-Secure-End-to-End- example, Big Tobacco has used the
system to block or obstruct health
IoT-Solution-with-IntegratedGateway,-Cloud-and-Edge-Devices laws intended to reduce smoking
in countries around the world.
While all of this is bad news in
full circle magazine #1 03

Many of the systems that have
been affected by the malware
were infected when attackers
exploited a vulnerability in the
Magento CMS. A critical
vulnerability patch for Magneto,
which is used to power a number
of e-commerce sites, was
published on October 31 . Doctor
Web researchers currently place
the number of victims in the "at
least tens" range, but attacks on
other vulnerable content
management systems could
increase the number of victims
dramatically.

In order to run, the malware has
to be executed with administratorlevel privileges. Using 1 28-bit AES
N EW ENCRYPTION
crypto, the malware encrypts the
contents of all users' home
RANSOMWARE TARGETS
directories and any files associated
LINUX SYSTEMS
with websites running on the
systems. It then goes through the
he antivirus software company whole directory structure of
Doctor Web has issued an alert mounted volumes, encrypting a
about a new form of cryptovariety of file types. In each
ransomware that targets users of directory it encrypts, it drops a
Linux-based operating systems.
text file called
Designated as "Linux.Encoder.1 " by README_FOR_DECRYPT.txt. This
the company, the malware largely demands payment and provides a
targets Web servers, encrypting
link to a Tor "hidden service" site
their contents and demanding a
via a Tor gateway.
ransom of one Bitcoin (currently
about $500).

T
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Source:
http://arstechnica.com/security/20
1 5/1 1 /new-encryptionransomware-targets-linuxsystems/

LINUX FOUNDATION
LAUNCHES O PEN SOURCE
H IGH -PERFORMANCE
COMPUTING G ROUP

T

he Linux Foundation, a
nonprofit organization that
promotes the Linux kernel and
other open source projects, has
partnered with Dell, HP Enterprise,
Intel, Fujitsu Systems Europe and a
number of university research labs
to create the OpenHPC project.
The collaboration will center on
four main goals:
Producing a stable environment
for testing HPC software
Creating an open source
framework for HPC environments
that will reduce costs
Developing a sophisticated HPC
software stack suited to a variety
of applications
Building a configuration
framework that offers developers
and users flexibility to tailor HPC
software to meet their needs.

The time is right for new
investment in open source HPC
software because such software is
vital in fields like meteorology,
astronomy, engineering and
nuclear physics, yet it has not been
developed in a central, efficient
way, according to the Linux
Foundation.
Source:
http://thevarguy.com/opensource-application-softwarecompanies/linux-foundationlaunches-open-source-highperformance-co

'SMALLER THAN A CREDIT
CARD ': TINY

SUPERCOMPUTER COULD
MEAN SELF -FLYING DRONES

W

ith NVIDIA's new machine
learning module, companies
will be able to specifically identify
construction vehicles, building
materials and other structures, so
they'll have even more relevant
information to manage their job
sites using commercial drones".
As a result, the platform is
capable of performing complex
full circle magazine #1 03

tasks such as recognizing images,
processing conversational speech,
or analyzing a room full of
furniture and finding a path to
navigate across it. Nvidia described
the Jetson TX1 's machine learning
abilities as "a groundbreaking
technology that will give
autonomous devices a giant leap in
capability".

"Just looking at the patch itself,
things look fairly normal at a high
level, possibly a bit more driverheavy than usual with about 75
percent of the patch being drivers,
and 1 0 percent being architecture
updates," said Torvalds in a release
statement.
"The remaining 1 5 percent is
documentation, filesystem, core
networking (as opposed to
network drivers), tooling and some
core infrastructure."

NVIDIA would like us to think
that its newly announced Jetson
TX1 is a few sort of AI upgrade for
computers and networks, one built
to aid autonomous systems by
He also explained that driver
enabling machine learning.
changes for staging, networking
and GPU drivers account for 40
Source:
percent of the entire kernel patch.
http://heraldvoice.com/201 5/1 1 /1
5/smaller-than-a-credit-card-tinyAround half of the content is
supercomputer-could-mean/
aimed at ARM-based architecture,
while x86 and others make up the
other half.

LINUX 4.4 GLIMPSES THE
FUTURE WITH ITS FIRST
RELEASE CANDIDATE

L

The change list is, as ever,
phenomenal in size, but includes a
number of improvements for IoT
support for ARM processors and
updates for DRM.

INUX IS already past the point
when, in theory, Skynet should
have created a T-800 Terminator to
There are likely to be up to 1 0
save John Connor, and Linux
release candidates before the real
puppetmaster Linus Torvalds has
deal is released sometime next
released the first release
year.
candidate for kernel version 4.4.
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http://www.theinquirer.net/inquir
er/news/2434899/linux-44glimpses-the-future-with-its-firstrelease-candidate

FREESCALE M AKES
SIGNIFICANT I NVESTMENT IN
REAL TIME LINUX

F

reescale has just announced
they are joining the Real Time
Linux (RTL) Collaborative Project
as a Gold Member. Freescale joins
Google, National Instruments,
OSADL, and TI with a significant
investment because they value the
strategic importance of this open
source project and the benefits it
creates for their customers.
Linux adoption for embedded
applications is following a similar
path to what we saw in mobile,
where smartphones and their apps
drove new experiences and even
further commercial success of
Linux (via Android) in the
marketplace. In the case of
embedded systems, advances in
artificial intelligence, image and
voice recognition are sparking
massive innovations based on the

power, flexibility and cost
advantages of embedded Linux
systems. For example, in drones
and cars we are seeing a
convergence of advanced image
recognition and artificial
intelligence giving way to pilotless
and driverless navigation. From
robotics, to drones, to cars, a real
time Linux kernel is key to the
foundation of these soon-to-be
commercially available solutions.

industrialists, family offices and
private equity firms,” according to
Numecent. Deutsche Telekom also
led the company’s series A round.

“Numecent is on a good
trajectory and is receiving traction
from major players in the
industry,” Vicente Vento, chairman
of the supervisory board of
Deutsche Telekom Strategic
Investments in a statement. “This
traction validates the view that
Source:
cloudpaging is potentially
http://www.linux.com/news/featur transformative not only for IT, but
ed-blogs/204-mike-woster/867455- also for emerging sectors like IoT.”
freescale-joins-real-time-linuxproject-as-gold-member
Source:
http://venturebeat.com/201 5/1 1 /1
7/numecent-raises-1 5-5m-to-bringN UMECENT RAISES $1 5.5M cloudpaging-to-android-and-linux/

TO BRING CLOUDPAGING TO
ANDROID AND LINUX

I

TEXAS I NSTRUMENTS – KIT

rvine, California-based software
company Numecent said today it ENABLES FAST AND EASY
has raised a new round of $1 5.5
LINUX SOFTWARE AND
million from a broad range of
HARDWARE DEVELOPMENT
European investors as the company
seeks to expand its cloud-based
he OMAP-L1 38 DSP+ARM9
services beyond Windows.
development kit, from Texas
Instruments (TI) is designed to
The series B round includes $4.5 enable fast and easy Linux
million from Deutsche Telekom,
software and hardware
with the rest from “European
full circle magazine #1 03
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T

development.
The scalable platform can ease
and accelerate software and
hardware development of
everyday applications that require
real-time signal processing and
control functional, including
industrial control, medical
diagnostics and communications.
The low-cost kit, complete with
freely downloadable and
duplicable board schematics and
design files, greatly reduces design
work. A wide variety of standard
interfaces for connectivity and
storage allow developers to easily
bring audio, video and other
signals onto the board. Expansion
headers such as LCD screen
expansion headers and Leopard
Imaging’s camera sensor allow
users to extend the board’s
functionality.
The TMDSLCDK1 38 replaces the
TMDXLCDK1 38 with the same
performance, price and features. It
available on a limited quantity
basis as inventory ramps, says the
company.
The LCDK does not have an
onboard emulator. An external
emulator from TI (such as the
contents ^
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XDS1 00, XDS200, XDS51 0,
XDS560) or a third-party will be
required to start development.
Source:
http://www.electropages.com/201
5/1 1 /texas-instruments-kitenables-fast-easy-linux-softwarehardware-development/

LINUX D EBUGGING COMES
TO VISUAL S TUDIO

M

demonstrated this week when 3DR
(Solo) and DJI (Phantom)
announced similar new technology
to make it easier for their
customers to avoid restricted
airspace . France-based Parrot was
an early leader in consumer
unmanned aerial vehicles (UAVs)
with its AR.Drone quadrotors,
which bridged the gap between
the toy and prosumer/commercial
markets. Parrot also owns a big
chunk of the toy drone and robot
market with products like the
Rolling Spider and Jumping Sumo,
as well as a newer line of Jumping,
Source:
http://www.infoq.com/news/201 5/ Airborne, and Hydrofoil minidrones, selling from $1 45 to $220.
1 1 /vs-gdb
communication. As Goodner
explains, certificates have to be
generated to enable secure
communication but do note that
pass phrases cannot be used at this
time so it probably makes sense to
generate a separate certificate just
for this purpose. You will also
want to make your first connection
using your SSH client outside of
Visual Studio so the certificate can
accepted. Subsequent connections
can then be made within Visual
Studio.

icrosoft has released a
preview of its new Visual
Studio GDB extension,
contributing to their ongoing
effort to make Visual Studio
PARROT’S B EBOP 2:
support as many development
SMALLER , FASTER , LONGERenvironments as possible.
Microsoft's Marc Goodner has
LASTING , LINUX-FORTIFIED
provided details of this new ability,
which can be used with Visual
n San Francisco, Parrot unveiled a
Studio 201 5 Community edition or
smaller, faster, longer lasting
higher.
version of its Linux-based Bebop
drone, helping to solidify its
Once installed, this extension
dominance in the mid-range
provides a new Project target
consumer market. One of the key
under Visual C++ ->Cross Platform new features is an emergency
called “Makefile Project (GDB)”.
cutoff that instantly kills the
Once created, an SSH client will be quadrotor motors when a blade
needed on your local/host
hits an obstacle. The increasing
Windows machine to enable
focus on safety was also
full circle magazine #1 03
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Source:
http://linuxgizmos.com/parrotsbebop-2-smaller-faster-longerlasting-linux-fortified/

ARDUINO M EETS LINUX:
ARDUINO I NTRODUCES I TS
3 RD G ENERATION
PLATFORM

T

development tool within the
Maker community.
Now, a third generation of
Arduino boards is emerging that
contains two processors. 3rd-gen
boards such as the Arduino Yun
have an embedded microcontroller
(MCU) and a more powerful
microprocessor Unit (MPU), similar
to those found in PCs and mobile
devices. The MCU (typically an
Atmel ATmega32x device)
supports the real-world I/O
functionality traditionally handled
by the Arduino platform. The MPU
is typically based on the MIPS
architecture (such as the Atheros
AR9331 ) and powerful enough to
support application languages
such as C/C++, Python and Java.
The microprocessor can also
support multiple communication
protocols (Wi-Fi, TCP/IP, HTTP etc)
and web-based services (Chat, email, Twitter, AllJoyn etc).
Source:http://electronics360.gl
obalspec.com/article/5995/arduino
-meets-linux-arduino-introducesits-3rd-generation-platform

he Arduino platform's
simplicity, open architecture
and ease of use helped make it the
most popular embedded

9

contents ^

CO M M AN D & CO N Q U ER

L

Sta ti c Si te G en era ti on

Written by Lucas Westermann

ast month, I wrote about
Ubuntu Phone, intending to
follow up on it this month.
Unfortunately, I’ve lacked the time
to complete the article for this
issue – you can expect it to be in
next month’s issue. Instead, I’ll
discuss a new website creation
tool called ‘static site generation’.
If you’re not interested in
websites, and want to learn more
about Ubuntu Phone
programming, check back next
month!

B UT… WHY?

WHAT IS STATIC SITE
GENERATION ?

A site I am working on was
originally created using Django
CMS - where it would load in about
61 2ms from my local machine (with
no network latency, a quad core
CPU, and an SSD), which is
perfectly reasonable. Shifting it to
an Nginx server running uwsgi saw
the load times jump up to 700B UT MY CMS SITE LOADS
800ms. However, the more content
that was added to the page, the
QUICKLY?
longer it would take. Version 3.2 of
It’s possible to have a site load Django CMS seems to have
very quickly when being used with improved on the speed, but it is
not, as of writing, at a final release.
a CMS, but this is generally the
The equivalent site using Pelican (a
result of a great deal of testing,
and plenty of performance tweaks. static site generator) loads in

Static site generators are
command-line tools that can take
content from formats such as
markdown and reStructuredText,
and insert the content into HTML
templates. At the most basic, you
can think of it as a content
management system that, when
compiled, doesn’t save content to
a database, but straight into a
static html page.

Anyone who has had to work to
optimize a page for performance
knows that static sites load much
faster (and with less effort),
because there is no delay while
querying the database, or while
running for-loops to insert
information. Naturally, some sites
lend themselves to content
management systems (really large
sites, sites with various editors and
moderators, or sites that need to
serve dynamic content). As is
always the case in web design, it’s
a matter of picking the right tool
for the job, in order to create the
site as fast as possible, to have it
perform well, and to avoid
reinventing the wheel at every
turn.

full circle magazine #1 03

A COMPARISON
Note: According to studies by
Google, any site that takes longer
than 1 second to load (on mobile,
mainly) will generally have users
leave due to the wait. Studies from
Amazon and Google also saw that
an increase of loading time of 1
second (say, for example, from
400ms to 1 .4s) could result in a
drop of revenue between 1 4 and
1 8%.

10

402ms, and the only optimization I
have done so far is to merge my
CSS files. There is no compression
of any sort running, and is being
served only with python
http.server. As the site is a
redesign for my own company, and
I will be the only one managing it, I
have no need for a CMS – I could
just as easily write the HTML by
hand. However, the number of
pages make it unreasonable to
create everything by hand, which is
where Pelican comes in. I can
manage my content easily in
reStructuredText (or, theoretically,
anyone who knows Markdown,
HTML, or reStructuredText), and
can assign various templates to the
pages, according to the meta
information. The resulting static
site can be hosted easily and
quickly on Nginx, and use less
resources than a Django CMS
setup running Nginx, uwsgi, and
postgresql. Note: this is not a
criticism of Django CMS, as I could
probably optimize my approach in
order to reduce load times. A static
site generator simply reduces the
amount of optimization I need to
accomplish.
contents ^

COMMAND & CONQUER
I’M SOLD! WHERE DO I
START ?
There are various static site
generators on offer. The most
common and well-known is Jekyll,
which is used for GitHub Pages,
among other things. Jekyll uses
the Liquid templating language,
and is written in Ruby. I, however,
am currently using Pelican, and for
two main reasons:
It uses Jinja2 for templating,
which is the same as Django.
Meaning I could carry over existing
templates quickly.
It is written in Python, and so
has integrated translation options
for multilingual sites (using Jinja2
i1 8n). As my site is always in
English and German, this was a big
factor for me.

has a slightly different file
structure, and different commands
to compile, it’s necessary to check
the documentation. Once you’ve
D OES THIS MEAN I CAN ’T
created a project (most likely done
USE FORMS , OR ANY
with a quickstart command), then
DYNAMIC CONTENT AT ALL? it’s time to create some sample
content, and a template (or to
Forms are essentially just HTML adjust an existing template).
that gets sent via POST (typically)
to a php file. If you use a
M Y SITE IS DONE...DO I HAVE
combination of Nginx and apache
TO BUY HOSTING ?
(or just apache), you can still
include a php file for sending the
Since static HTML is so easily
information around. Depending on
served, there are some offerings
what you mean by dynamic
content, it should be possible too. where you can upload a site
without much trouble. For
iFrames or widgets from other
example, GitHub Pages.
sites shouldn’t be an issue, or, if
Technically, you could even host it
you want to semi-dynamically
in some fashion on Dropbox. So,
create a grid (for example), you
depending on your needs, you may
can create templates using fornot need to pay for additional
loops to iterate through
hosting - or if you do, you’ll most
information in order to insert it
likely not need too powerful a
into HTML. If you’re looking for
server to adequately serve the
login areas and personalized
content.
HTML, a CMS will probably be
easier for this.
options before choosing a
generator.

So, depending on what you’re
most comfortable with, you may
prefer Jekyll over Pelican, or a
number of other static site
generators over either. Use what
you’re comfortable with, as it will
O KAY, I’VE INSTALLED A
help cut down the learning curve.
GENERATOR . WHAT NOW ?
If you want to use plugins for
automatic integration of bootstrap
Now would be the time to
(for example), then I would
check the homepage and view the
recommend checking the plugin
documentation. As each generator
full circle magazine #1 03

SHOULD I OPTIMIZE?

Depending on how quickly your
site loads, you may not feel you
need to. My recommendation, at
least, is to optimize images and
enable server compression if your
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site is going to be mobile-friendly.
Assuming, of course, that you’ve
minimized your CSS and JS already.
You’ll most likely not need to do
every optimization you can for that
last 3% decrease in size, but some
basics are recommended.
I hope this article has been
interesting for anyone looking at,
or working on, a project where you
keep thinking “this site is almost
too small for a CMS, but too large
for doing it by hand!”. Or anyone
interested in creating a quick
project website for GitHub. If you
have questions, suggestions, or
comments, you can reach me at
lswest34+fcm@gmail.com.

FURTHER READING
Jekyll homepage:
https://jekyllrb.com/
Pelican:
https://github.com/getpelican/peli
can

Lucas has learned all he knows from

repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.
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Written by Greg D. Walters

elcome back to the new
direction of my Python
series. In case you missed last
month, I am changing the direction
of this 5 year series from teaching
programming in Python to what is
called Physical Computing using
Python. When you see the phrase
'Physical Computing', think of
buttons, LEDs, motors, sensors
(temperature, humidity, motion
sensors, barometric sensors, etc.)
and more. The reason I decided to
do this was that after 5 years, I
thought I had shown pretty much
everything that you needed for
“normal” computing, so let’s focus
on what I consider the future of
small computer programming and
microcontrollers.

articles, we will be interfacing with
sensors and the Arduino microcontroller.

A BRIEF HISTORY OF THE RPI
Much of this information comes
from the official Raspberry Pi
website
(http://www.raspberypi.org) and
my memory of buying my first RPi.
When the Raspberry Pi first came
out, there were two models –
Model A+ and Model B+. The
decision tree was fairly easy since
the two different versions fit a
“simple or full feature” mindset, as
you can see in the gross details
presented below (They are now
called RPi 1 Models)…

In February 201 5, both of those
models were superseded by the
RPi 2 Model B. It shares a good
deal with the RPi 1 B+, but has a
900 MHZ Quad-core ARM CortexA7 CPI and 1 GB Ram.
You can find various models of
the RPi at any number of web
retailers. My humble suggestion is
to get the RPi 2 Model B if you can
afford the difference in the price
between the P1 Model B (it
shouldn’t be that much of a delta).
Any of the code that we create in
the next few articles should easily
work with any version of the RPi.
While you are searching the
web for your RPi, you will see

This month, I will be going over
selecting a Raspberry Pi (yes there
are more) that will fit your goals,
installing an operating system
onto the SD card and starting the
RPi for the first time with the new
OS.
Next month, we will start
learning to respond to switches
and control LEDs. In future
full circle magazine #1 03

12

various kits and add-on modules
like cameras, servo controllers,
motor controllers and so on. At
this point, the add-ons won’t be
needed, but we might use some in
the future, so if it is something
that you are interested in use your
own judgment. As to the kits, here
are some things you should
consider before you invest in the
“ultimate kits”. In the next few
articles, we will need :
• A Raspberry Pi computer.
• A power supply. For the P1
versions, a 5 VDC 1 -1 .2 amp cell
phone charger with a micro USB
connection (normal for many smart
phones today) will work well. For
the P2 version, I strongly suggest
that you get a power supply that
has an output of 5 VDC 2.5 amp
power supply with a micro USB
connector.
• A USB Keyboard and Mouse.
While many places offer very small
keyboard/mouse combos, for
programming work and “normal”
computer use, you will want a full
size version of both. You can move
to the small wireless versions later
on if you decide to use the RPi for
contents ^
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other uses like a multimedia centre
or expanded home automation.
Normally when I work with the Pi, I
use a VNC server on the Pi and a
VNC client on my linux machine, so
I don't have to have multiple
keyboards and mice on the top of
my desk.
• A 4-8 GB SD Card that is Class 1 0.
Versions P1 A and B used SD cards.
P1 Model B+ and above have
switched over to a Micro-SD card
only support. Keep this in mind
when buying a specific version. Of
course you can use a bigger card.
Officially they say that testing has
been done with 32 GB cards and
don’t see many issues with most of
the larger cards. Please Be careful
when buying SD cards, since they
are not all created equal. Just
because a cheap card is marked
“Class 1 0” doesn’t actually mean
that it is going to work like a more
expensive card.
• Some sort of Internet connection,
either USB Dongle or Ethernet
cable.
• A HDMI monitor/television for
output and HDMI cable. If HDMI is
not available, the P1 A and B
versions provide a RCA Composite
Video out and 3.5mm Audio Out
connector. The P1 B+ version and
later have done away with the RCA
Composite Video connector and

has replaced it with a 3.5mm jack
that combines audio and video in
one. You would need a 3.5 mm to
3 RCA connectors to connect to an
older TV.
• Speakers or headphones (unless
the monitor or device you are
using supports HDMI audio).

at SparkFun, their item is called the
“Pi Wedge”. Unless you want to
assemble your own (read this as
soldering tiny parts), you will want
to get the Preassembled version.
This one costs about $1 0.00 U.S.. I
believe that they have retired
(discontinued) the version for the
RPi 1 A and 1 B. You CAN elect not
While this is the “minimum”
to get the interface board and
requirement list for this article, for ribbon cable and use female (Pi
our first project you SHOULD have side) to male (breadboard side)
the following items available…
jumpers. These will work,
however, in some of the things we
• Breadboard – The breadboard
do later on, if you get the jumper
will be needed to start working
on the wrong pin of the Pi, it could
with add on discrete components
lead to damage to your Pi.
like LEDs, resistors, switches, etc.
• Various Resistors, LEDs and Mini
without having to do any
pushbutton switches. I will give
soldering.
you a list before we need them to
• GPIO interface board (header)
give you plenty of time to obtain
and Ribbon cable. This will
them. You can get these at many
connect the GPIO pins from the
places.
RPi to the breadboard. Check out
• One other thing you might
http://sparkfun.com or
consider is a case, but only if you
http://www.Adafruit.com for this
have the breakout boards and
item. The item you will want to
ribbon cables. This will protect
look at from Adafruit is called “Pi
your Pi from your handling of it.
T-Cobbler Plus”. Note that this
particular item will NOT work with S ETUP OF YOUR RP I
the RPi V1 A or B. It will only work
with the later versions. It is
Now comes what must be for
currently about $8.00 U.S.. If you
me, the most tedious part of the
are using a model A or B, you
project… the setup. The steps we
should get “Pi T-Cobbler” which is will perform are:
about $7.00 U.S. If you are looking
full circle magazine #1 03
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• Download the OS image.
• Unpack the image file from the
archive file. Put it somewhere it's
easy to get to.
• Installing OS to the SD Card.
• Getting the RPi hooked up.
• First boot of the RPi with the new
OS.
So, let’s get the OS image. Go
to the downloads page on the
official Raspberry Pi website
(https://www.raspberrypi.org/dow
nloads). You will be presented
multiple versions of various images
that you can download, including 2
versions of Ubuntu (The GUI
version is Ubuntu Mate), Windows
1 0 IOT and more. If you have an
older model (original models A or
B), neither of the Ubuntu images
or the Windows image will run on
these models. You need the
ARMV7 processor and the extra
memory to be able to use these
images.
The two we are interested in
for this project, are the NOOBS
and the RASPBIAN images. I will
be using the RASPBIAN Wheezy
image dated 05-05-201 5 for our
first few projects, but if you want
to have the option of booting into
other OS images on the same card,
contents ^
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feel free to download the NOOBS
image. Just remember, if you have
more than one OS on the card, you
have less space available to the
RASPBIAN image and you will run
into an issue that I always used to,
not enough space for all the things
you want to try. Assuming that
you are doing your work on a Linux
machine, you can see the official
installation instructions at
https://www.raspberrypi.org/docu
mentation/installation/installingimages/linux.md . If you are using
a Windows machine or a Mac,
follow the links there. I’m going to
assume a Linux machine and will
give you the instructions here.
Before we get started, you
might be asking why, if there is a
newer/better version available, am
I using the older version. I’ve had
some trouble with the ‘J essie’
release and am more comfortable
with the ‘Wheezy’ release at this
time. I doubt that this was an issue
with the release, probably just a
bad download, but I just wanted to
let you know. For the purpose of
the next few articles, use ‘Wheezy’
and feel free to play with other
versions.
Unpack the archive and have it
be sent to a folder that will be easy

for you to remember.

I NSTALLING THE OS I MAGE
TO THE SD CARD
If you are using an early version
of the Pi, you will be using a
standard sized SD card. If you are
using a later version you will be
using a Micro-SD card. To save me
having to type the distinction
every time, I will use “SD” in the
documentation. One more thing
before we start. I STRONGLY
SUGGEST that you do not use a
device connected to an external
USB hub for the imaging of the SD
card. I know the specs say you can,
but I've never had very good luck
doing this.
OK, here we go. Before
inserting the SD card into your
Linux box, open a terminal and do:
sudo -i

Most of the commands don't
actually need the sudo level
permissions, but it won't hurt and
neither you or I have to remember
when they do. Now run “df -h” to
see what devices are currently
mounted in the system. My system
responds as shown below. Yes, I've
full circle magazine #1 03

named my machine Slartibartfast.
Slartibartfast ~ # df
Filesystem
Size
/dev/sda1
451G
none
4.0K
udev
3.9G
tmpfs
796M
none
5.0M
none
3.9G
none
100M
/dev/sdd1
2.8T
EXT
/dev/sdb1
1.8T
/dev/sdc1
917G
Slartibartfast ~ #

-h
Used Avail Use% Mounted on
336G
93G 79% /
0 4.0K
0% /sys/fs/cgroup
4.0K 3.9G
1% /dev
1.5M 794M
1% /run
0 5.0M
0% /run/lock
124M 3.8G
4% /run/shm
32K 100M
1% /run/user
2.5T 314G 89% /media/greg/TOSHIBA
1.5T
681G

294G
190G

84% /media/greg/extramedia
79% /media/greg/MoreMedia2

Notice that I have 4 drives (sda1 , sdb1 , sdc1 and sdd1 ). I hope that when
I plug in the SD card, it will come up as /dev/sde1 . This will be important
to know because if we get the wrong /dev/ device, we will corrupt it!
Now plug your SD card into the computer and run “df-h” again. My
system responds as:
Slartibartfast - # df-h
Filesystem
Size Used Avail Use% Mounted on
/dev/sda1
451G 336G
93G 79% /
none
4.0K
0 4.0K
0% /sys/fs/cgroup
udev
3.9G 4.0K 3.9G
1% /dev
tmpfs
796M 1.5M 794M
1% /run
none
5.0M
0 5.0M
0% /run/lock
none
3.9G 124M 3.8G
4% /run/shm
none
100M
36K 100M
1% /run/user
/dev/sdd1
2.8T 2.5T 314G 89% /media/greg/TOSHIBA
EXT
/dev/sdb1
1.8T 1.5T 294G 84% /media/greg/extramedia
/dev/sdc1
917G 681G 190G 79% /media/greg/MoreMedia2
/dev/sde1
56M
20M
37M 36% /media/greg/boot
/dev/sde2
30G 3.0G
25G 11% /media/greg/13d368bf6dbf-4751-8ba1-88bed06bef77
Slartibartfast - #
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Thank goodness! However
/dev/sde1 has two partitions. This
will be important in the next step.
If you are me, please write down
the drive information so you don't
make a mistake. Now you will want
to unmount the SD card drive.
Slartibartfast ~ # umount
/dev/sde2
Slartibartfast ~ # umount
/dev/sde1
Slartibartfast ~ # df -h

Notice that I started yet
another “df -h” just to verify that
the device is unmounted.
If you have ever used this SD
card for anything before, you will
want to remove the partitions
before proceeding further. Some
people might argue that this is not
necessary, but why not? It only
takes a few seconds and it keeps
us from having problems. Use
“gparted” to remove all the
partitions.

Slartibartfast Raspbian # dcfldd bs=4M if=2015-05-05-raspbian-wheezy.img of=/dev/sde
768 blocks (3072Mb) written.
781+1 records in
781+1 records out
Slartibartfast Raspbian #

We are about to write the
Raspbian image to the SD card.
There are two ways to do this.
First is to use the “dd” command
AS SUDO, which I'm sure will be
the first thing that comes to
everyone's mind. However,
remember when we use “dd”, we
don't get any information coming
back to tell us what is going on and
if it takes 5 minutes or longer to
write the image, we won't see
anything that entire time in the
way of progress. While there are
other methods I'm going to
suggest that instead, you can use
the “dcfldd” command (shown top
right). Once it gets started (which
could take a minute or so) it will
give a progress report about how
much has been written. Pick your
“weapon” of choice. I'm going to
show “dcfldd”. Now, as SUDO,
please change to where ever you

Slartibartfast Raspbian # ls -al
total 7424016
drwxr-xr-x 2 greg greg
4096
drwxr-xr-x 3 greg greg
4096
-rw-r--r-- 1 greg greg 3276800000
-rw-r--r-- 1 greg greg 4325376000
Slartibartfast Raspbian #

Oct 31 12:02
Oct 23 20:11
May 7 2015
Sep 24 16:14

Slartibartfast Raspbian # dd bs=4M if=/dev/sde of=wheezy2015-11-07.imgsafe
7609+1 records in
7609+1 records out
31914983424 bytes (32 GB) copied, 1675.51 s, 19.0 MB/s
Slartibartfast Raspbian # truncate --reference 2015-05-05raspbian-wheezy.img wheezy-2015-11-07.imgsafe
Slartibartfast Raspbian # diff -s wheezy-2015-11-07.imgsafe
2015-05-05-raspbian-wheezy.img
Files wheezy-2015-11-07.imgsafe and 2015-05-05-raspbianwheezy.img are identical

have unpacked the image you are
going to use.

want to verify the write so that
you can be sure that this matches
the image. We will make an image
I show (below) an “ls” command of the SD card we just did and
here. I do this so I can remember
write it to a temporary image file
the name of the file that I'm just
back to the hard drive. Since your
about to work with, and I have the SD card will likely be bigger than
exact spelling.
the one they used to create the
distribution image, we will need to
On my machine, the process
truncate our copy to match the
took about 1 0 minutes total.
size of the original and finally use
diff to verify that both images are
This next step (above) is totally the same. Remember this could
optional, but if you are like me, you take a rather long time if you have
a card larger than about 8Gb. I'm
using a 32Gb card and it looks like
it's going to take probably 30+
.
..
minutes to copy the image to the
2015-05-05-raspbian-wheezy.img
drive.
2015-09-24-raspbian-jessie.img

full circle magazine #1 03
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As you can see, the images are
the same, so if there is anything
wrong from here until we log in,
it's not our fault. This process
could be a useful process as you go
along and want to make a backup
image of your Pi's “drive”, just in
case something happens.

Plug in the Ethernet cable into
the Ethernet port or Wireless
dongle into the USB Port.

this once.

You will see a screen with 9
options on it. We will work with
Switch on your monitor or TV
numbers 1 ,3 and 4.
and get it set to the proper mode
• Option #1 - Asks about
(HDMI or Composite).
expanding the file-system. You
really want to do this so you can
Plug in the video cable (HDMI
get the most space you can. It will
Finally, we want to run the sync or Composite).
take effect at the next reboot.
command which will make sure
• Option #3 - Enable boot to
that anything remains
Put the SD card (or Micro-SD
Desktop/Scratch. You should go
uncommitted in the write cache is card) into place. It doesn't matter
ahead and set this to Desktop
flushed and that is ok to unmount if you are using a full size SD card
Login as User 'Pi' at the Graphical
the SD card.
or a Micro-SD, you will insert it
Desktop.
with the label facing down, not up • Option #4 – This sets various
Now we can move on to some
towards the bottom of the Pi. And things that we take for granted by
more “exciting” things. Powering
whatever you do, DO NOT remove our automated setup systems.
on the Pi.
the SD card while the RPi is
They include Locale, Timezone and
powered on.
Keyboard Layouts.
• First select Locale. Since this
G ETTING READY TO POWER
At this point, we are ready to
computer comes from the UK, its
UP YOUR RP I
plug in the power, so take a deep
default is to select things that
breath and cross your body parts.
someone living there would need.
Notice how I worded the
Plug it in.
I, on the other hand, need to
heading for this portion of the
change some settings. I have to
instructions. There are certain
If it worked, then we'll move on. let the window scroll down to
things you should do before you
If not, please retry the instructions EN_US.UTF-8 UTF-8 and select it.
apply power to your RPi. There are above.
Follow the prompts and you'll be
possibilities you can damage your
fine.
RPi if you don't do the steps in
Once you get Pi booted into a
• Next I need to set my timeorder.
distribution for the first time, you zone. Since I live in Colorado, USA, I
will presented with the raspiwould select America under the
Plug in the Keyboard and
config application. We are going
Geographic area, and Denver for
Mouse into the USB port/ports.
to want to tweak some of the
the Time Zone.
settings. We only really need to do
• Finally I have to select the
full circle magazine #1 03
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keyboard layout I wish to use. It
asks a lot of questions, so I would
select “Generic”, “US”, “US”,
“Default”, ”No Compose Key” and
“No” to Xserver Termination key.
Finally I'm ready to set it up, so I
select “Finish” and “yes”. Your Pi
should reboot and you should see
the normal desktop. Now we want
to update the system to the latest,
add a couple of applications that
we'll need right away and then let
it reboot once again.
Open a terminal off the top
menu bar and do:
sudo apt-get update
sudo apt-get dist-upgrade

Now we want to install
TightVNCServer. While this is an
optional step, I find it much more
constructive to use the Remote
window on my Linux desktop than
be forced to have 2 monitors,
keyboards and mice. It always gets
me confused about what/where I
am.
sudo apt-get install
tightvncserver

Once that's set up, it will ask
you to create a password, so no
contents ^
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one can just jump into your screen.
Make it easy for you to remember.
The very next thing we want to
do is set the tightvncserver to
automatically startup on boot.
That way we don't have to have a
mouse or a keyboard.
• Change to the home directory if
you aren't already there.
$ cd /home/pi

• Next, change to the .config
directory.
$ cd .config

• Now we will make a new
directory here called 'autostart'.
$ mkdir autostart

Move over to your normal
computer and load VNCViewer
software on it. Once that's all
done, you will probably want to
spend a moment or two by
rebooting the computer and
making sure that the VNC really
did start up and connect. If
everything works, you are done.

surprised by the power of this tiny
device.
So until next month, the last
thought I will leave you with is
something we hear here in the U.S.
all the time...
“But wait … there's more!!!!!!!”

You will need (as I said earlier) a
few things for next month. Some
male to male jumpers, female to
female jumpers, the breadboard,
interface and cable and a handful
of things from the electronics
store…

• Change to the autostart directory
• Some small LEDs. Try to get
we just created.
$ cd autostart
around 1 0 of each Red, Green,
• Now create a new configuration
Yellow and Clear.
file. $ nano tightvnc.desktop
• Some small ¼ watt resistors. 220
And enter the following lines:
ohm, 4.7K ohm, 1 0K ohm, and
[Desktop Entry]
some other “normal” hobbyist
Type=Application
resistors. About 1 0 each will do
Name=TightVNC
Exec=vncserver :1
you and the salesperson at the
StartupNotify=false
local shop should be able to get
• Save the file (^O) and exit (^X).
you what you need.
• A couple of small switches (spst)
Almost done now. The last
that will fit on the breadboard.
thing we will need to do is install
(usually comes with 4 pins).
the IDE we will be using for our
code development, which is Geany.
Really that's about all you will
need for the next article. In the
sudo apt-get install geany
meantime, enjoy playing with Linux
on the Pi. I think you will be
full circle magazine #1 03

The Ubuntu Podcast covers all
the latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but
aren’t overly technical. We are
lucky enough to have some
great guests on the show, telling
us first hand about the latest
exciting developments they are
working on, in a way that we can
all understand! We also talk
about the Ubuntu community
and what it gets up to.
The show is presented by
members of the UK’s Ubuntu
Linux community. Because it is
covered by the Ubuntu Code of
Conduct it is suitable for all.

Greg Walters is owner of RainyDay

Solutions, LLC, a consulting company
in Aurora, Colorado, and has been
programming since 1 972. He enjoys
cooking, hiking, music, and spending
time with his family. His website is
www.thedesignatedgeek.net.
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The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.

podcast.ubuntu-uk.org
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Written by Elmer Perry

hen you have some data to
analyze, do you gather your
data into a spreadsheet, format
the sheet, and then stare for hours
at the numbers wondering what
they mean? No! You create a chart
that represents the data. While a
chart can help you see the overall
results of the data, how do you
examine how individual datapoints fall into the overall scheme
of things? Conditional formatting
can help you focus in on the datapoints making up your data set.
LibreOffice provides us with
many different conditional
formatting options, allowing us to
find a setup that will work for
many different types of data. We
discussed one of the conditional
methods back in part 43 under
statistical functions (Full Circle 91 ).
Today, I want to add three more
conditional formatting options to
your data analysis arsenal, Color
Scales, Data Bars, and Icon Sets.

M ETHODS OF CALCULATION
In all three methods, you create
a range or condition for your data.

Li breO ffi ce Pt.5 4 - Con d i ti on a l Form a tti n g
The range or condition is
controlled by 6 different methods
for calculating values. Let's look at
each of the methods.
• Minimum – The smallest value in
the data set.
• Maximum – The largest value in
the data set.
• Percentile – The percentile
ranking of each value within the
minimum to maximum range of the
data points.
• Value – The value is based off a
fixed number you enter.
• Percent – The part each value is
of the total sum of the data set.
• Formula – The value is set by a
cell reference or a formula.

COLOR SCALE

Color Scale is a conditional
format that highlights values in a
gradient of chosen colors
depending on their value. This
method gives you a quick visual
clue about where a value lies
within the overall range. You can
use 2 or 3 colors to create your
scale. I will demonstrate both.
We will set up a range of values
to demonstrate how the scale

While percentile and percent
may seem like the same thing,
mathematically they are different.
A percentile breaks the difference
between minimum and maximum
into 1 00 pieces and reports where
the values fall in those 1 00 pieces.
A percent shows how much the
value is of the total sum of all the
numbers in the set.

full circle magazine #1 03
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closer to the middle. It might help just that.
to format the cells font color to
white so they stand out against the
To set up our data for the data
colors better.
bars, select the cell range L1 :L1 1 .
Edit > Fill > Series. In the Fill dialog,
select down for the Direction,
D ATA B ARS
Linear for the Fill Type, -50 for the
works. The range we are creating is numbers are highlighted by a
start value, and 1 0 for the
Data Bars are like a quick-andlinear so you can see the way the
Increment. Click OK. The data will
gradient of colors starting with the dirty bar chart right in your
colors graduate from one to the
default red and blending more
spreadsheet, creating a data mixed fill in from -50 to 50 in increments
other. Start by entering the value 1 with the blue until it gets to the
of 1 0.
with chart effect. To make data
in the cell A1 . Select cell range
center, then the red starts to fade bars look good, it helps to make
A1 :A1 0. Edit > Fill > Series. In the
To create the data bars, select
out as it graduates back to blue at the columns a little wider. We will
dialog, select Down for the
the end. So, you can see here how place our data bars data at the end the cell range L1 :L1 0. Format >
direction, Linear for the Series
the scale works. If your number is
of our previous table so you can do Conditional Formatting > Data
Type, and 1 0 for the Increment
Bars. Just like the color scale, the
highlighted in a purplish color, you
value. Click OK. The values will fill know that it is a mid-range value.
in. Now, select cell range A1 :J1 0.
The more red, the closer to the
Edit > Fill > Series. Select Right for beginning; the more blue, the
the direction, Linear for the Series closer to the end.
Type, and 1 for the Increment
value. Click OK. If you did
We can add a third color to the
everything correctly, you will have scale, increasing the visual effect.
the values from 1 to 1 00 in 1 0
Format > Conditional Formatting >
rows.
Manage. Select the condition in
the list and click Edit. Switch the
Now, let's set up our Color
top center dropdown to Color
Scale. If not still selected, select
Scale (3 Entries). The three center
cell range A1 :J1 0. Format >
entries relate to the third color.
Conditional Formatting > Color
Select Percentile for the type, 50
Scale. Color Scale is always set at
for the value, and Green 3 for the
All Cells. Set the top center
color. Click OK. Click OK again to
dropdown box to Color Scale (2
close the Manage Conditional
Entries). Leave the rest of the
Formatting dialog. You now have
settings at their default values.
two color gradients. Red to green,
Click OK. Notice the range of
green to blue. The more green, the
full circle magazine #1 03
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setting must remain on all cells.
You can use any of the calculation
methods to create your upper and
lower range, but leaving it on
automatic shows the best results
for our data. Click OK. You will see
that the cells are split in half. The
negative numbers grow to the left
in red, and the positive numbers
grow to the right in blue. Notice
the gradient scale on both colors.
But that's not the end of this
story. Did you notice the More
Options button? Maybe you even
clicked on it. You're the type who

likes to get ahead, aren't you? Well,
let's go back and take a look at
those options. Let's edit our data
bar range, Format > Conditional
Formatting > Manage. Select the
Data Bars range (L1 :L1 1 ) and click
the Edit button. Finally, click on the
More Options button.
Here you can adjust the
minimum and the maximum just
like in the dialog. The Bar Colors
options allow you change the
colors for positive and negative
numbers. The Fill lets you change
from Gradient to Color (solid).
Position of the Vertical Axis
changes the position of the center
or zero line. Automatic will adjust
its position depending on the type
of numbers you have. For positive
numbers, it automatically leftjustifies the bars, but for negative
numbers, it automatically rightjustifies the bars. For a mix of
positive and negative numbers,
Automatic centers the 0-axis line;
Middle forces the vertical axis to
the center of the cells; None forces
the bar to left-justify, even the
negative numbers. With None, the
only way to know positive from
negative is by the color. Using
Middle or None for the vertical axis
activates the Bar Lengths. Here
you can adjust the minimum and
full circle magazine #1 03

maximum lengths as a percentage.
If you want all values (except zero)
to show a bar, you can set the
minimum to 1 . Or, if you don't want
the bars to go all the way to the
left or right, you can set the
maximum to something other than
1 00 (say 80). Play around with
these options to see what kind of
results you get. The Display Bar
Only check-box causes the cells to
just show the data bars and hides
the number values.

I CON SETS

average them, and then use three
arrow icons to determine whether
the values are above or below the
average.

For the setup, select cell range
A1 3:A24. Edit > Fill > Random
Number. Set Distribution to
Uniform Integer, Minimum to 50,
and Maximum to 50,000. Click OK.
In cell C1 3, enter the formula
=AVERAGE(A1 3:A24).

Icon sets are used to show
whether a value is below, equal to,
or above a defined value. The icon
sets come in several varieties, and
in sets of 3, 4, or 5 icons. Use them
according to the style and number
of icons you need. We will set up a
group of random numbers,
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To set up our icons, select cell
range A1 3:A24. Format >
Conditional Formatting > Icon Set.
Change both of the dropdown
boxes to the Formula method. In
the first text-box with the yellow
right-pointing arrow, enter the
formula as =C1 3. If the value of the
cell equals the value in C1 3, the
yellow arrow will show in the cell.
If the value of the cell is less than
the value of C1 3, the red downarrow will display in the cell. In the
second text-box, enter the formula
=CEILING(C1 3, 1 , 0). The CEILING
function takes the number
provided, in this case the value in
cell C1 3, and rounds it up
according to the value in the
second argument. Since we have 1
as the second argument, the
function will round the number up
to the next whole number. The
third value, set at 0 in our case,
controls whether negative
numbers are rounded according to
their actual value or absolute
value. In order to round based on
the absolute value, you would set
the third argument to something
other than 0 (zero). Click on the OK
button, and the arrows will show in
the cells based on their
relationship to the value in C1 3.

Conditional Formatting gives us
the ability to give visual clues
about the values in a spreadsheet
without having to create a chart or
graph. Color Scale sets the
background color on a cell – based
on its value within a defined range.
Data Bars creates a mini bar-chart
directly in the cells. Icon Set marks
the cells with icons based on their
conditional relationship to some
value. Each method has its own
function, giving you a different
style of results. Just like when
creating a chart or graph, you have
to make the decision about which
one works best for your
application.

Elmer Perry's history of working,

and programming, computers
involves an Apple ][E, adding some
Amiga, a generous helping of DOS
and Windows, a dash of Unix, and
blend well with Linux and Ubuntu.
He blogs at
http://eeperry.wordpress.com
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Bi bli og ra ph i es I n La TeX

Written by John Eddie Kerr

or this edition of the LaTeX
segment, I will tell you a little
bit about BibTeX and how it can
help you. To help liven up a dry
subject, I’ll compose an ultra-short
paper, and I’ll include information
about that great album by the
Beatles: “Sgt. Pepper” – that you
probably did not know about! But
first... you need to know about a
bibliographic software called
Zotero.

thousands of YouTube videos on
how to use Zotero. There are also
very good videos on how to create
citations and bibliographies.

What does Zotero do for you?
Suppose you are conducting
research for a term paper. You are
searching online for journal
articles. When you find one that is
on point for your paper, you can
click a tiny icon on your browser
and all of the bibliographic
information that you need is
Zotero is a plug-in for Firefox.
downloaded to your own database.
To describe it well, I will post a
You also have the URL for the
quote here from the Zotero
article, and a copy of the article is
website:
downloaded to your computer.
“Zotero is the only research tool Zotero can download bibliographic
that automatically senses content in data for any book you find in a
yourweb browser, allowing you to library catalogue. Almost anything
addit to yourpersonal library with a that you find on the Internet can

single click. Whetheryou're
searching fora pre-print on
arXiv.org, a journal article from
JSTOR, a news story from the New
York Times, ora book from your
university library catalog, Zotero has
you coveredwith support for
thousands ofsites. ”
And, just like LaTeX, there are

be catalogued by Zotero, all with a
click of a mouse.
It is these little
icons that do all the
magic for you:
Z opens the Zotero database;
the blue book icon downloads the
bibliographic information – note
that different icons appear for
various types of media.

ALTeditor = {editor},
title = {title},
publisher = {publisher},
year = {year},
OPTkey = {key},
OPTvolume = {volume},
OPTnumber = {number},
OPTseries = {series},
OPTaddress = {address},
OPTedition = {edition},
OPTmonth = {month},
OPTnote = {note},
OPTannote = {annote},
}

Many LaTeX editors will create
the appropriate template for the
So where is the connection to
item you wish to record. Quite
LaTeX? And BibTeX?
simple to use, inside the { } we just
type in the information required.
Zotero will export your data in The most important field is the
many forms, one of them is the
field on the first line. “ID” must be
BibTeX format and it looks like this: a unique identifier or “key”. So, for
a book I would have written, the
@Book{ID,
key could be “jek201 5”.
ALTauthor = {author},

@book{martin_little_1994,
address = {Boston},
edition = {1st U.S. ed},
title = {With a little help from my friends: the making of {Sgt}. {Pepper}},
isbn = {978-0-316-54783-3},
shorttitle = {With a little help from my friends},
publisher = {Little, Brown},
author = {Martin, George and Pearson, William},
year = {1994},
keywords = {1961-1970, Beatles, England, Rock music},
annote = {Includes index}
}

full circle magazine #1 03
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It would be tedious to type in
all of that information, but at least
this way you have to type it only
once. But Zotero can do all of that
for you, here (previous page,
bottom right) is a citation that I
harvested from the catalogue at
my local library with a click on the
blue icon in my browser.
All that typing was done for you
with a click of a mouse way back
when you were searching the
library online catalogue. To export
the record, highlight the record
(multiple records can be done by
holding down the ctrl-key while
you click on other records required
for the bibliography).
Right click and choose Export
Items, scroll in the next window to
BibTeX, then click OK.

Sometimes we may want to
tweak the records. I would change:
martin_little _1994

to
gmartin94.
@book{gmartin94,
address = {Boston},
edition = {1st U.S. ed},

Unfortunately, we can edit the
record key only in the BibTeX file,
not the Zotero file. So if you have a
BibTeX file that you have modified,
and then you want to add another
record, you will have to export that
record to its own file and then copy
and paste the data into the main
BibTeX file.
Now, sometimes we have to
manually enter records, I find that
for recording websites, Zotero

does a great job but the BibTeX
output can enter many excess '{ }'
that have to be edited out. Just a
warning.
Here is a record that I created,
to record a conversation I had with
one of the pioneers of FM rock,
David Marsden of the Internet
radio station
https://www.nythespirit.com:
@misc{_interview_????,
title = {Interview : {David}
{Marsden}},
url =
{https://www.nythespirit.com/
},
publisher = {unpublished},
annote = {When I heard
Sargent Pepper I knew that
rock music had to move to the
FM band because AM just could
not deliver the sound that
the rock musicians were
making. At that time, the FM
band was the sacred ground of
classical music. It was a
tough fight and it took a
year for it to happen.}
}

The annote field is a good place
to enter any text that you want to
quote in your paper.
full circle magazine #1 03
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SO HOW DO WE GET THIS ALL
TO WORK?
The bibliography file must end
with the letters bib (Zotero does
that for you), and must also be in
the same directory as the file that
your document is in. (Creating a
directory for your LaTeX document
is the first rule of LaTeX).
The bibliographic file in this
project is called Pepper.bib.
In the preamble add this line:
\bibliographystyle{plain}

To your document at the end,
just before /end{document}, add
this line:
\bibliography{the name of
your file.bib}

or in this case:
\bibliography{Pepper.bib}.

The name of the file is case
sensitive so make sure that you
type the name of the file exactly.
There are many bibliography
styles to choose from but I will just
use the plain style in my ultra-short
contents ^
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paper. Here are some sites that
cover the bibliography style in
more detail, with examples:
http://www.cs.stir.ac.uk/~kjt/softw
are/latex/showbst.html
http://www.reed.edu/cis/help/LaT
eX/bibtexstyles.html#seven

years when the DJ's could practise
Free Form FM radio (that was
before the suits discovered there
was more advertising revenue to
extract), I encourage you to
explore David Marsden's own show
on Saturday and Sunday nights
8:00 pm Eastern time at this site:
https://www.nythespirit.com/.
Code “BEMX” will give you a onemonth free trial.

Many colleges and universities
have information regarding
bibliographic styles, and also
LaTeX templates for a thesis, on
their websites; enquire at the
institution you are attending.
Whenever you want to cite a
source in your paper, type \cite and
Sometimes you may have to
your LaTeX editor should list the
compile
your document more than
citations in your BibTeX file for you
once to get the bibliography to
to insert:
compile, that can be normal.

The bibliography is created
when you compile your document
and it all will look something like
this:

This article has just scraped the
surface of the bibliography
component of LaTeX. There are
other ways of approaching this,
and there are many other options
in the BibTex bag of tricks. There is
a new format called BibLateX, and
Zotero will export bibliographies in
this format as well. However I must
say that – thanks to the BibTex
export feature that we have in
Zotero, and that Zotero makes
data harvesting from databases so
easy – I am in favour of the BibTex
full circle magazine #1 03

file method which is creating a .bib
file of your references that resides
in the directory of the document
you are creating.
I wish I had LaTeX and BibTeX
way back in the days when I was
writing my papers at University,
back in the days when FM stereo
was about as high tech as it got.
Today, with a little help from your
friends (all those people who have
created the free software), writing
a class paper is so much easier. I am
green with envy.

By now I suppose the suspense
is killing you, and you have to know
the identity of the real Sgt. Pepper.
He was a policeman who was on
the security team when the
Beatles visited Toronto. That
morsel of information is on the last
page of Sir George Martin's book
which is full of interesting tidbits.
It is a must read, I enjoyed it. Until
next time, enjoy LaTeX.

A shameless plug is in order. If
you would like to hear what FM
Rock radio was like in the early
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Pra cti ce You r Prog ra m m i n g

Written by Attila-Mihály Balázs

rogramming is an activity
where you need to
continuously learn to stay
productive. Programming
languages, libraries, tools,
operating systems - they all
change. This means that last year’s
solutions that you find on the
Internet might not be applicable
this year. Thus we need new
content (be it blog posts,
documentation, books or other
forms) showing the current best
way to achieve a given goal. One
solution is StackOverflow with its
voting system (where out-of-date
solutions get voted down and
working solutions get voted up)
and others are blogs. The problem
with blogs is that people rarely
have time to blog frequently
and/or don’t have expertise and a
diverse set of domains, thus
readership interest can waver.
There are tries to encourage
people to blog regularly (such as
the Perl Iron Man Blogging
Challenge), however, it is easier to
sustain a blog with multiple
authors (also called collaborative
blogging).

A programming Advent
calendar is such a collaborative
blog centering around one
language / framework / library or
subsection of the IT field. Just as
you open one door of an Advent
calendar every day between the
1 st and 24th of December to find a
surprise, these blogs publish one
article each day for the first 24
days of December about their
respective topics surprising,
informing and delighting their
readers.
Some of the programming
Advent calendars are:

J AVA ADVENT CALENDAR
http://www.javaadvent.com/

I’m partial to this, having started it
4 years ago :-). It contains articles
about all kinds of technologies
related to the Java Virtual
Machine, not just Java the
language. For example, we had
articles about two of the oldest
languages running on the JVM
(besides Java): NetRexx and Kawa.
full circle magazine #1 03

THE PERL 6 ADVENT
CALENDAR

https://perl6advent.wordpress.co
m/

SYSADVENT

https://sysadvent.blogspot.com
Interesting articles for system
administrators and anyone curious
about the field of IT.

Perl 6 is a new programming
language to be released this
Christmas, so if you’re interested in UXM AS
Perl 5, this is a good site to follow http://uxmas.com/

PERLADVENT

http://www.perladvent.org/
If you’re not ready to make the
jump to Perl 6 yet (since it’s a
completely new language, not just
a superset of Perl 5), here you can
find all kind of interesting details
about it.

24WAYS

“An Advent calendar for UX folk.”

PERL D ANCER ADVENT
CALENDAR

http://advent.perldancer.org
“The PerlDancer Advent Calendar
is a community-driven project that
aims to showcase the Dancer Perl
web framework.”

https://24ways.org/

24 PULL REQUESTS

“24 ways is the Advent calendar for
web geeks. For twenty-four days
each December we publish a daily
dose of web design and
development goodness to bring
you all a little Christmas cheer.”

This isn’t a collaborative blog, but
rather an effort to encourage
people to contribute to free /
open-source software on GitHub
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Q IITA ADVENT CALENDARS
http://qiita.com/advent-calendar

There are a lot of topics covered
here (and I mean a lot - in 201 4
they had 21 4 different Advent
calendars with different topics).
Unfortunately, you need to be able
to read Japanese to enjoy it.
These are the ones which are
currently active (there were others
which unfortunately are no longer
available).
You can subscribe to any of
these using your favorite RSS
reader (for example Liferea,
RSSOwl, feedly, NewsBlur and so
on) to ensure that you never miss a
post. Some of them (like
JavaAdvent) also offer other
means of subscription (like Twitter,
Facebook, Google+ or even email).
Finally, all of these sites
welcome (and in fact depend on)
user contribution. So go ahead and
subscribe to them and also
consider writing an article or two
yourself! As they say: the best way
to understand something is to try
to explain it to others!
full circle magazine #1 03
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Written by Mark Crutch

efore we delve too much
further into Live Path Effects,
there are some implementation
details that are worth pointing out.
The first is that LPEs don't exist in
the SVG specification. They're an
Inkscape-specific thing, and no
browser or other SVG editor knows
how to render them. Go on, give it
a try. Create a nice chain of gears,
or a Spiro path, then save your SVG
file. Open it in a modern web
browser and see what you get.
Here's my file, opened in Firefox.

Well, it certainly looks like my
original Inkscape file, but how can
that be if the browser doesn't
know anything about LPEs? The

answer can be found by looking at
the XML code for the file, either
via Inkscape's XML editor (Edit >
XML Editor, or CTRL-SHIFT-X), by
viewing the page source in your
browser (CTRL-U in Firefox), or
simply by opening your SVG file in
a text editor. You'll see that the
main body of the image is made up
of an SVG <path> element. The “d”
attribute contains a series of
letters and coordinates that tells
an SVG-aware application how to
draw the final path, after any
visible LPEs have been applied. It's
like a snapshot of the result, in a
format that your browser
understands.
Notice that there are some
other attributes, in the “inkscape”
namespace. In particular you'll find
“inkscape:original-d”, which holds
the path definition of the original,
skeleton path. There's also an
“inkscape:path-effect” attribute,
which holds a semicolon-separated
list of XML IDs. These refer to
<inkscape:path-effect> elements
up in the <defs> section of the
XML, which is where all the
parameters for your effects are
full circle magazine #1 03

stored.

(File > Vacuum Defs on 0.48).

So, in summary, Inkscape uses
the “original-d” attribute and
<path-effect> elements to hold all
the information it needs to draw
the LPE. Other applications use the
“d” attribute to render a snapshot
of the final path, with the LPE
applied. When you modify an LPE
within Inkscape, it automatically
updates the “d” attribute to match
the rendered output, so other
applications should always be able
to display your drawing as
intended, even though they don't
know anything about LPEs.

Because Inkscape calculates the
final path from the original path
and LPE parameters, using live
path effects places more of a
burden on the processor, resulting
in slower rendering speeds. Usually
this isn't an issue, but when
zooming into a very complex
drawing it can become noticeable.
If you're happy with the LPE
output, and don't need to change
it any further, you can “fix” the
path so that it looks the same, but
is no longer based on path effects.
Essentially this process just
removes the Inkscape-namespaced
Inkscape doesn't always do a
attributes from the path element,
great job of clearing out unused
leaving it with just the same “d”
elements in the <defs> section of a attribute that any other
file, and path effect definitions are application uses. To do this, simply
no exception. If you add and
use the Path > Object to Path
remove a number of LPEs whilst
menu entry (CTRL-SHIFT-C). It may
experimenting with your drawing, seem odd to use Object to Path on
old definitions tend to build up
something that's already a path,
there. They don't do any harm, but but think of it as converting an LPE
do slightly increase the size of the path to a plain SVG path, and it
file. You can clear them out,
makes more sense. Like any other
together with other unused
Object to Path conversion this is a
definitions, by using the File >
strictly one-way affair, so make
Clean Up Document menu entry
sure you keep a backup of the file
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from just before the change, in
case you subsequently find you
need to modify your LPE
parameters after all.
That's enough behind-thescenes detail for now, let's press
on with another path effect! As
usual we'll need a path to work on,
so let's start by drawing a simple
arrow shape.

The path effect we'll look at
this time is “Bend”, so add that to
your path following the
instructions from the previous
instalment. As before, there's no
immediate change to your image,
but the LPE dialog has gained a
few controls at the bottom. Of
particular note is this quartet of
buttons:

This arrangement of buttons
appears frequently in LPEs,
whenever an extra path is required
as part of the input parameters. In

the case of the Bend effect, two
paths are required: the original
skeleton path (the arrow shape, in
this case), and a bend path whose
shape dictates how the skeleton
path should be distorted. These
buttons are for managing the bend
path, as follows:

the LPE. I'll discuss this button in
more detail a little later.

But there's more! Your bend
path doesn't have to be limited to
a pair of end nodes connected by a
curve. You can add extra nodes,
turn them into corners, mix
straight and curved sections, have
the path double-back on itself, or
even split it into several sub-paths.
Admittedly, getting too complex
with your bend path can lead to a
degree of contortion that's hard to
control, but the options are there
for you to explore.

If you press the first button you
should find that a straight green
path appears on the canvas,
directly over your skeleton path.
This is the bend path, and you can
manipulate it in the same way as
• The first button allows you to edit any other. Try dragging the path
the bend path directly on the
itself, or use the node handles, to
canvas. This is the most commonly distort its shape, noticing how the
used of the four.
skeleton path is morphed in real• The second button lets you copy time to match your changes. You
the bend path to the clipboard.
can also move the nodes
From there you can paste it into
themselves, in order to stretch,
another LPE, or even paste it
compress or rotate the skeleton
directly into the canvas as a new
path. If the bend path disappears –
path in its own right. These copies usually due to a mis-click causing
maintain no connection to the
the skeleton path to become
original bend path.
selected – just click on the first
• The third button is for pasting a
button of the quartet in the LPE
path to use as the bend path. This dialog to make it reappear. With
could be one that you've copied
barely any effort the Bend path
from another LPE using button
effect can turn your straight arrow
two, or it could be a path you've
into a curved or sinuous shape that
constructed elsewhere in your
would take a lot more time and
Using the second and third
canvas. Again, there's no
work to produce using normal path buttons you can copy and paste
connection maintained to the
editing techniques:
the bend path from one LPE to
original path.
another, which can be handy if you
• The final button lets you link to
want several skeleton paths all
an existing path, rather than create
distorted in the same way. Each
a new bend path. In this case there
bend path will be an independent
is a live connection to the original
copy, though, so changes to one
path, so any changes you make to
won't affect the others.
that are immediately reflected in
full circle magazine #1 03
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Sometimes it's useful to have
multiple bend paths all linked to a
single “master” path, such that
changes to the shape of the
master are immediately reflected
in each individual LPE. The fourth
button allows you to achieve that
effect, but it's not without its
difficulties.
For this example I'm going to
use two different kinds of arrow,
and I want to apply the Bend LPE
to both of them such that they
follow the shape of the green path
at the bottom of the image.

the stored reference to define the
bend path. Clicking this button has
two immediate effects: the arrow
is distorted to match the bend
path, as expected, and the arrow is
moved to the same location as the
bend path – which is not what I
wanted! If I add a Bend LPE to the
second arrow and link that to the
bend path, that also gets moved.
I've got all the right shapes, but
not necessarily in the right
locations.

of ways around this problem.
Inkscape has a setting hidden away
in Edit > Preferences > Behaviour >
Transforms labelled as “Store
Transformation”, with options of
Optimised or Preserved (it's in File
> Inkscape Preferences >
Transforms on 0.48). Use
Optimised and you'll see the
behaviour I've described above –
LPE paths strongly bound to their
linked bend path. Set it to
Preserved, however, and you can
move them around with impunity.
Of course there's a trade-off:
Optimised results in slightly
smaller, more efficient files,
whereas Preserved potentially
stores additional data for any
object that's been transformed,
not just the ones that are causing
us problems.

Whichever approach you take,
you should now have two separate,
independently positioned arrows,
both of which are linked to the
shape of the master bend path.
Modify that path and you'll see the
arrows shape change accordingly.
If you don't want to see the bend
At first this might seem like a
path in your final design, simply
fairly trivial problem. Just drag the
it behind another object, set
arrows back to where you want
If you want to leave the setting hide
its opacity to 0 (use View > Display
them, right? Unfortunately that
as Optimised, there is a second
> Outline to find it again) or
doesn't work – drag them away and alternative which allows you to add Mode
just move it onto a hidden layer.
they'll spring right back to the
extra data to just the problem
The remaining controls for the
location of the bend path. Drag the paths. It's a little counter-intuitive, Bend
LPE are fairly simple. The
The first step is to select the
bend path away, and they both
but it does the job perfectly: just
spinbox lets you control the
green path and copy it to the
follow along after it. Being able to select your path and add a second Width
scaling of the skeleton path,
clipboard. As well as copying the
link to a common path seems a lot Bend effect to it. You don't even
perpendicular to the bend path.
path data itself, Inkscape also
less useful if it means that your
have to modify the bend path –
with it to see the effect. The
stores a reference to the original
linked shapes all have to sit on top just adding the effect is enough to Play
“Width in units of length”
object. Next I need to select one of of each other.
let you drag your path around
checkbox has a slightly misleading
the arrows, add the Bend LPE, and
independently of the linked bend
title: “keep width proportional to
click on the fourth button to use
Fortunately there are a couple
path once more.
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HOWTO - INKSCAPE

length” would be a better name.
Check this, and the width of the
path is scaled as the length of the
bend path changes; leave it
unchecked to keep the width
unchanged regardless of the shape
of the bend path or the position of
the end nodes. The final checkbox
is quite self-explanatory: if you
wish to bend a path that's more
vertical than horizontal (e.g. an
upwards facing arrow), then check
this box, otherwise you'll be
distorting along the width of the
shape, rather than its length.
The Bend LPE is one that's well
suited for use with text, to
produce the sort of “Word Art”
effects so beloved of parish
newsletters in the 1 990s. Because
LPEs won't work directly on a text
object, you first have to perform
the one-way conversion of your
text into a complex path. Using
Path > Object to Path will result in
a group of individual paths, one for
each letter. We really want a single
path encompassing the whole text,
so it's easier to use Path >
Combine, which will convert your
text into paths, and combine them
into a single complex shape, all as
one operation. The final result will
be a group of one object, so you'll
probably want to ungroup as well.

From there you're free to add a
Bend effect and distort your text
as you would with any other path.
Before you race off to convert
your text into a path, however, it's
worth considering the downside:
the shape is no longer a text
object, so you can't subsequently
edit the content if you find a
mistake. Often a similar result can
be obtained by drawing a separate
bend path, then selecting both
your text and path before using
Text > Put on Path. You may need

to manually kern some of the
characters to get the right result
(see part 1 1 ), but it has the distinct
advantage of keeping your text
editable. In this image the red text
was converted to a path and bent,
the green is the same text put
onto a copy of the bend path, and
the blue is the same as the green,
but with some manual kerning
applied.
One noticeable difference
between the approaches is that

the LPE distorts the shape of the
letters, whereas text-on-a-path
maintains their original shapes.
Sometimes the distortion effect is
desirable, in which case I can only
recommend that you save a copy
of the file just prior to converting
to a path, in case you do need to
edit it later.
Next time we'll move beyond
simple path bending and into the
kind of full-on distortions that can
turn some simple text into a 1 970s
album title, as we continue to look
at Inkscape's live path effects.

Mark uses Inkscape to create three
webcomics, 'The Greys', 'Monsters,
Inked' and 'Elvie', which can all be
found at
http://www.peppertop.com/
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AR D U I N O

I D E 1 .6.6

Written by Ronnie Tucker

he first week in November
brought an update to the
Arduino IDE. The upgrade to 1 .6.6
brings in an impressive 720+ bug
fixes.

B EST N EW FEATURE
There are several new features
(that I’ll probably never use) such
as a command-line tool, a new
modular architecture, lots of bug
fixes, etc, etc, but for me it’s all
about:

Having said nice things about it,
there are also many comments
floating around the Internet saying
that 1 .6.6 has some seriously bad,
and some say critical, bugs.

In other Arduino news: I just
bought a RepRap Fisher Delta 3D
printer kit which is sort of Arduino
powered. It uses a board based on
the Arduino Due. So, in the next
month or two, expect the Arduino
So, if you REALLY want to
section to cover 3D printing. I’m
update: go for it, but be aware that hoping to do some time-lapse
it’s currently not without its risks.
video/photography of the build,
and probably end up writing a
review of it too.

Ronnie is the founder and (still!)

editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.

Serial Plotter - Now we’re
talking! This I can use. By using a
command like:
Serial.println(analogRead(A0)
)

you can view real-time data in a
nicer way than just having numbers
flying past.
Having data output to the serial
monitor is really handy, but being
able to see it in a more visual way
is a great new addition!

U H OH !
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CH RO M E CU LT

Priva cy

Written by S. J. Webb

aimed to provide an encryption
how-to using a Chrome browser
and the app store. However the
recent news by Google caused this
impromptu opinion piece. Chrome
OS and Android are being merged
into a new OS. The beta OS will
premiere in 201 6 and the full
hybrid of mobile and cloud OS will
emerge. It will be ready for
consumers in 201 7. There are no
details about the name for this
new OS or hardware associated
with it.

Chrome OS is too popular to
completely kill off.
Let’s review Google’s two OSes
independently: Android and
Chrome. Android is the leading
mobile OS, with a strong app
developer presence. However it is
plagued by being insecure, and
lacks proper and timely security
patches. Chrome is extremely
secure using native SSD
encryption, web app sandboxing,
and security updates every 6
weeks. Yet Chrome has a much
weaker app store developer
presence. Ideally, by merging the
security of Chrome OS and the
Android App Store together,
Google will get scale and
efficiency. They will have more
users on the Google Ecosphere by
pushing this new hybrid OS.

The Pixel C is priced around
$500. However it will come with
3GB RAM, Nvidia Quadcore
processor, Maxwell GPU and a
32GB or 64 GB SSD. The Pixel is still
Wi-Fi dependent. This device is
following the trend of tablets
sales, since desktop computers are
declining. This device will still make
Google relevant as consumer
trends change.

After using my Chromebook for
the last few months, I would
recommend it as a backup
computer to a Linux distro or
Google has given conflicting
MacBook. I would recommend my
reports of maintaining the Chrome
Chromebook as the main computer
OS for the current Chromebook
over any Microsoft OS. I do not
base. In an ideal world the new
mind living in the cloud as long as
hybrid OS will run on the
limitations are known. I suspect a
Chromebooks without fault. If not,
Chromebook-like device will be my
I will be using Crouton for Ubuntu
kid’s first laptop. I learn to adapt to
Mate.
my Chromebook. Undoubtedly I
Google has already started to
will learn to adapt to this new OS
People are split on this decision.
create an Android Chromebook
coming out in 201 7. For the time
They believe Google is killing off
Prototype.
It
is
called
the
Pixel
C.
It
being, Chrome Cult will continue to
the Chromebook, despite the
offers the tablet features, but with review the cloud computing
continued growth and popularity.
an optional keyboard. I believe this experience.
Others believe it is a natural
evolution of the Google Ecosphere. will be the first computer that will
sport the hybrid OS.
Google has killed off unpopular
items in the past. However the
full circle magazine #1 03
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SJ Webb is a Linux Hobbyist and

Research Coordinator. He enjoys
fishing, hot rodding, and spending
time with his kids and wife. He
thanks Mike Ferarri for his
mentorship.
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H OW-TO

Wri te For Fu ll Ci rcle M a g a zi n e

Written by Ronnie Tucker

G UIDELINES

T

he single rule for an article is
that it must somehow be

document.

REVIEWS

• Images should be JPG, no wider
than 800 pixels, and use low
compression.

G AMES/APPLICATIONS

linked to Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc). • Do not use tables or any type of
bold or italic formatting.

RULES

• There is no word limit for articles,
but be advised that long articles
may be split across several issues.
• For advice, please refer to the

Official Full Circle Style Guide :

http://url.fullcirclemagazine.org/7
5d471
• Write your article in whichever
software you choose, I would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND

GRAMMAR CHECK IT!

• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

If you are writing a review,
please follow these guidelines :
When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

TRANSLATIONS
If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you
access to the raw text to translate
from. With a completed PDF, you
will be able to upload your file to
the main Full Circle site.
full circle magazine #1 03

When reviewing games/applications please state clearly:
•
•
•
•
•
•
•

title of the game
who makes the game
is it free, or a paid download?
where to get it from (give download/homepage URL)
is it Linux native, or did you use Wine?
your marks out of five
a summary with positive and negative points

H ARDWARE

When reviewing hardware please state clearly:
•
•
•
•
•
•
•

make and model of the hardware
what category would you put this hardware into?
any glitches that you may have had while using the hardware?
easy to get the hardware working in Linux?
did you have to use Windows drivers?
marks out of five
a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
35
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L I N U X L AB

B u i l d i n g A 3 D P ri n te r

Written by Charles McColm

latest project: the Vaster Mini3 3D
printer outlined on
Instructables.com:
http://www.instructables.com/id/B
uilding-a-3D-Printer-Under-299/

R

ick Jenkins is a volunteer with
The Working Centre’s
Computer Recycling Project.
Besides being a good computer
technician he’s also a very skilled
artist, 3D modeller and all around
tinkerer.

Ubuntu made sense for the
computer running the 3D printer
because there were already
packages for the makerbot
software. Rick uses Slic3r, which
does the same as the makerbot
software, and Blender to build the
models.

3D printers have been available
for a few years now and Rick
predicts that within 5 years there’ll
be models cheap enough that
most people will have at least one
3D printer in their home. Part of
the impetus for building (over
buying) the 3D printer came from
the availability of local resources.
In Kitchener, Ontario, the local
maker group, Kwartzlab, has a
large laser cutter and several 3D
printers. The local library also has
several 3D printers. The other itch
to build (over buy) came from

Rick’s passion for tinkering has
in the past led him to create a
number of cosplay props ranging
from a full length steampunk
jacket to a steampunk gun that
featured a light-by-light power-up
effect and full sound effects. He’s
also a long time open source user
who started out with an early
release of Red Hat Linux. Currently
Rick uses Arch Linux on his home
system, but he chose to install
Ubuntu on the computer for his

Rick’s tinkerer nature.
The design for the printer came
from instructables.com which has
links to some of the sources for
the hardware, the motors and the
Arduino. The nuts and bolts were
bought at Spaenaur and the metal
rods and some of the additional
components were recovered from
old inkjet printers from the
Computer Recycling Project.
The greatest challenge building
the printer was collecting all the
information to build it. The initial
research before cutting out the
first part with the laser cutter was
significant. Knowing why he
needed to use each part was
important to ensure proper
operation: making sure the
stepper motors are moving the
right distance, making sure there’s
no print slide (instead of getting a
cube, getting a parallelogram misalignment).
Rick chose to build the Vaster
Mini3 over other instructable
designs, partly because of the way
it looked and partly because it was
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described as an under $300 make
your own 3D printer. In fact the
costs actually ended up around
$1 40. The most expensive parts
were the Arduino control kit and
the nema 1 7 motors. Rick had
extracted several motors from
inkjet printers, but because of
where the mounting holes were on
the design, it required the nema 1 7
motors.
printer_front.pngThe structure
of the 3D printer is mostly
complete after 1 ½ months
invested. Part of the time
investment was due to limited
access to the laser cutter, sourcing
local shops, and waiting for
ordered components to arrive. All
that’s left now is waiting for the
motors to arrive. Once parts are in
it should only take a couple of days
to do the initial complete
assembly, do the initial test prints
and recalibration.
With the structure assembled, a
good part of the 3D printer is built,
but there are still several things
that could go wrong. The Arduino
may not take the initial flashing of
its BIOS to tell it that it’s a 3d
printer. The Slic3r software may
provide standardized gcode that
the Arduino may not interpret

correctly. One of the Nema 1 7
motors may not work right. The
extruder assembly could jam and
malfunction. The motor feeder
may feed at the wrong speed
compared to the heater head. The
thermistor might misinterpret the
temperature. This is why Rick
spent so much time on initial
research.
On the computer side of things
Rick started with an old Pentium 4,
but found that Blender choked too
much. The Computer Recycling
Project had recently had several
generous donors so he ended up
reclaiming an AMD Quad Core A63620 APU system with 8GB RAM, a
1 TB hard drive and the onboard

Radeon HD6530D graphics. It
handles pretty much any Blender
design Rick throws at it.

machine can look at it and point
out anything wrong with it.

Rick plans to print replacement
For anyone thinking about
components for computers and
building a 3D printer, Rick suggests laptops as well as special personal
connecting to a source of
projects like a lightsabre, and
information, such as 3d printing
other costume accessories.
groups, so you can talk to other
people who have gone through the
People can contact Rick on
process of either buying or
Googleplus: gaelfling@gmail.com
building a 3d printer. It’s the best
resource. Online resources are
Kwartzlab:
great but they don’t always tell the http://www.kwartzlab.ca/
full story. In person you get
Vaster Mini3 printer:
immediate responses. Online there http://www.instructables.com/id/B
can be a lot of time wasted trying uilding-a-3D-Printer-Under-299/
to get the right answer. Also in
Ewaste $60 printer:
person, if you have the machine in http://www.instructables.com/id/e
hand, someone who has built a
Waste-60-3DPrinter/step2/Step-2Preparing-Motors/
Slic3r: http://slic3r.org/
Blender: http://www.blender.org/

Charles is the author of Instant

XBMC, and the project manager of a
not-for-profit computer reuse
project. When not building PCs,
removing malware, and encouraging
people to use GNU/Linux, Charles
has a blog at charlesmccolm.com.
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U B U N TU P H O N E S

Written by Ronnie Tucker

BQ AQUARIS U BUNTU
PHONE RELEASED IN RUSSIA

(http://www.ozon.ru/context/detai
l/id/34629381 /). The Aquaris E5 HD
Ubuntu Edition will be sold at a
price of 1 5,499 with the soon to be
launched Aquaris E4.5 at a price of
1 2,499.

• New 1 5.04.2 framework, UITK
offering new PageHeader
component
• New twitter scope, new book
aggregator scope
• Sound controls in the sound
indicator (Play, Pause)
• QtPurchasing based in-apppurchases

Russia continues to be an
important market for Ubuntu with
a strong and fervid fan-base and
developer community. Demand has WEBBROWSER:
also increased in the region since
• Media access permissions for
the initial launch of the devices
sites
back in February this year.
• Top level bookmarks view
• Thumbnails and grid view for Top
more:
Sites page
https://insights.ubuntu.com/201 5/ • Buteo used for contact sync
1 1 /1 7/bq-aquaris-ubuntu-edition- • Location service velocity and
phones-land-in-russia/
heading information
• OTA version numbering now
visible in system-settings (e.g.
OTA-8)
OTA-8
• Completely re-designed weatherapp
This list is only a highlight of
• Porting core-applications to UITK
the few changes available in this
update. Please check the detailed 1 .3
fter previous successful
changes for all the changes
launches of the Aquaris E4.5
and E5 HD Ubuntu Editions, BQ will included in this OTA.
B UGFIXES
now release Ubuntu Phones in
Russia. Devices will be available for I MPORTANT FEATURES
As we know, each release
purchase through a host of local
includes a huge number of bugs distributors such as Ozon.ru
full circle magazine #1 03
39

A

some for previous issues and some
for new regressions introduced inbetween. To see the overall list of
what issues got fixed, please check
the detailed changes below. The
interesting ones are as follows:
• Performance fixes for various
components (e.g. messaging-app,
SDK components)
• Fixes to location accuracy
• Reduced power use when there is
no network connection
• Call ringtone will play on
speakers with headphones
connected
• Fixes to reduce some of the UI
hangs due to dbus traffic
...and much much more.

D ETAILED CHANGES
Commitlog:
http://people.canonical.com/~lzem
czak/landing-team/ota/ota8.commitlog
Milestone bug list:
https://launchpad.net/canonicaldevices-systemimage/+milestone/ww46-201 5
contents ^
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B O O K R E VI E W

Th e B o o k O f G N S 3

Written by Lucas Westermann

WHAT IS GNS3?
GNS3 stands for Graphical
Network Simulator-3, and is a tool
to simulate networks (including
virtualized and physical hardware).
It is commonly used for testing
networks before deployment, or
for certification exams.

However, this is not a point against
the book - it doesn’t market itself
as a cookbook, but as a guide to
GNS3. Which it very much is.

STYLE

Jason C. Neumann manages to
write in a way that, while filled
with information, is still easy to
understand, and often amusing.
ABOUT THE B OOK
The book also contains a large
number of screenshots, which help
The book itself goes into detail the reader to follow the steps
as to what hardware/software the accurately. They are often placed
program can handle, as well as why in such a way that no paragraph is
you may want to use it. It’s geared cut off before/after the image,
largely towards networking
which helps the flow of text. If you
July 201 5, 272 pp.
engineers, or students studying
don’t feel you need the images,
ISBN: 978-1 -59327-554-9
networking in some fashion.
skipping over them should be a
https://www.nostarch.com/gns3
However, if you’re interested in
simple enough matter, without
dabbling, or want to study up on
abrupt line breaks in paragraphs or
ecently, I received a review
GNS3 for work on your own time,
sentences.
copy of “The Book of GNS3” by this book will probably fulfill that
Jason C. Neumann from No Starch need. While the book offers a
The formatting used for
Press. After having read through it, decent index, I have a hard time
commands and text ensure they
and testing out as much of the
seeing it fulfill the role of a quick- are easily read, and all characters
content as possible, I’m ready to
and-easy reference book. So if you can be identified without issue.
present my review. But before we don’t want to follow along step-by- Additionally, any changes to files,
get to the book itself, let’s answer step, or are looking more for a
or important segments, are
a question some readers will
cookbook-style book, you may
marked in bold. Combined with the
probably have.
want to look for alternatives.
screenshots, the formatting is
full circle magazine #1 03
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often enough to head off or solve
any issues you may run into. Not
only this, but the author sticks to
his formatting system in the actual
prose of the book as well. This
means any buttons, menu items or
other important words, are also
marked in bold. So if you’re
skimming through a page trying to
find where you went wrong, or
where that menu item disappeared
to, you’ll be able to easily catch it
on the page.

I NFORMATION
The book is OS-agnostic - it
covers installing GNS3 in Ubuntu,
Windows and Mac OS X, as well as
compiling it from source. It covers
all operating systems wherever
there may be differences, and
since large parts of the book focus
on virtualized hardware, it doesn’t
feel like you’re skipping paragraph
after paragraph if you’re using
Linux instead of Windows.
The book covers everything
from installing and setting up
GNS3, to physical and virtualized
hardware, and on to some projects
contents ^

BOOK REVIEW

“for a rainy day”. The author
focuses mainly on Cisco and
Juniper devices, but as they appear
to be the most common choices, it
seems like a good decision.

WRAP-U P
While this book is by no means
an exhaustive list of everything
that is possible with GNS3, it is an
excellent introduction, or a
supporting book for anyone
involved in a certification
exam/school course where GNS3
and Cisco/Juniper devices are the
focus. If you’re looking for a
cookbook or dry reference book
for quick and easy answers to
questions, you will most likely
need to keep looking (although I
do recommend keeping it on the
list, just in case).
If you’re trying to expand your
horizons on your own (for work or
for yourself), this book should be
able to guide you through GNS3
and give you enough information
to do so. However, you may need
to do a bit of googling, or
experiment with GNS3 on your
own, depending on your current
skill level and end goals. I should
also note that this is not a Cisco

networking certification study
guide, simply a book that covers
some aspects that may arise in the
exam. So if your goal is a
certification, you will need to
combine this book with the other
aspects of your particular exam.

While this book isn’t an
exhaustive resource, and won’t suit
everyone’s needs, it does achieve
exactly what it sets out to be: an
introductory guide to GNS3.

Lucas has learned all he knows from

repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.
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Written by AuntieE

ecause Ronnie had reported
the successful recovery of
over 500 photos with Photorec
after the Great Crash of his hard
drive in 201 4, I offered to try to
recuperate pictures on the HD of a
friend in the States whose
computer expert had said it would
be impossible to retrieve
anything... and yet it contained
pictures that were invaluable to
her. She mailed me the drive and,
after it had spent the night in the
refrigerator (NOT the freezer) I
went to work.
Windows 1 0 on a 4-year-old
Toshiba laptop kept offering to
format the two partitions (one
Windows RE-Store, the other,
apparently, system and data, in a
roughly 1 0-90% partition setup of
the 500 Go), but would then say
partitioning was impossible. The
disk utility of Lubuntu 1 4.04 (on a
Samsung Netbook that dates back
to 2007) didn’t even find the disk.
With nothing to lose, I googled
testdisk and went to the official
download page at
http://www.cgsecurity.org/wiki/Te
stDisk_Download where the latest

version is 7.0. I downloaded the
testdisk-7.0.linux26.tar.bz2 and
copied it to my home folder on the
Samsung. I then used the terminal
to unzip it with sudo tar xvf
testdisk-7.0.linux26.tar.bz2 which
created a folder called testdisk-7.0,
inside of which, among other
things, was testdisk_static and
photorec_static.
OK, I thought I’d start with
testdisk and both partitions came
up green, although the drive still
wasn’t recognized by the disk

full circle magazine #1 03

utility. (I admit that I didn’t go into
the log or try to understand
anything...) Instead, I then went
directly to photorec (everything is
done with the command line) : cd
testdisk-7.0, then sudo
./photorec_static. I got a page
asking me which drive I wanted to
recuperate things from : I chose
the Windows one first, but, after
about six hours, I stopped that and
started over.
I won’t bore you with my
umpteen tries that lasted
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overnight and beyond (until
everything got too hot to work),
BUT I finally realized that I could
use the options.
So: cd testdisk-7.0, sudo
./photorec_static, password, new
page, select partition, new page,
type of partition selected (in my
case FAT, etc.), new page, where do
you want to save the recuperated
files? It suggests doing it within
the testdisk folder, so I hit c (to
show that that was correct).
At some point, at the bottom of
the page where the first option
(Proceed) is automatically
selected, there is the possibility to
choose Options (arrow key + Enter)
and, there, to choose NOT to
disable Brute Force (in other words
to enable it), Enter. Then you can
move to the File Opt where you
can deselect everything by hitting
b (I think, I’m doing this from
memory because the Netbook
refuses to search the hard drive
any further...). All the X’s in the
boxes next to file types disappear
and you can navigate down the list
to choose what you really want, in
contents ^

MY STORY

my case JPG and DOC + Enter.
THEN you can return to Proceed
(with the left arrow key) and press
enter.

genealogy tables, but when I tried
to open them in both Linux and
Windows, I got a message they
were system files. Unfortunately,
at least half or more of the .jpg
With just two file types
files were in fact pictures from ads,
selected, the search was much
carpets, pants, dresses, etc., of
faster: 465 hours instead of 1 654, absolutely no interest. BUT 1 90
or something else unbelievable,
bona fide photos were recovered,
were announced. Any time you
although some of them are
want to Stop the search, all have to doubles.
do is press enter because STOP is
highlighted, and go through the
As to the huge recup_dir
rigamarole of Do you really want
folders, there seemed to be no
to Stop, etc. The best part is that
way to delete them. Even sudo
the next time you use photorec,
nautilus wouldn’t let me get rid of
you will be asked whether you
want to resume the search you
already started. Y + Enter. Select
where you want the recovered files
to be stored (c for correct). And off
it goes again...
What do you actually recover? If
you start with all the file types,
you’ll find yourself with 50 GB or
so of things in several different
folders named recup_dir.1 ,
through recup_dir.34, etc.
depending on how many times you
try things. Most of the .doc files I
recovered were system files (one
even weighed in at 480 MB – no
hope at all of opening it with
LibreOffice), several were .db,
which I thought might be
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them. Finally (thanks to something
I read in Full Circle recently), I tried
sudo su and nautilus and, at last I
could erase them and recover
some space in my Netbook’s hard
drive.
To sum it all up, I guess that the
keys to success with Photorec are
obstinance, patience and
discernment. Tomorrow, I’m
mailing my friend a full CD of her
lost pictures and that is what I
would call a triumph: the triumph
of Lubuntu, photorec, and sheer
persistence.
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If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org .
PLEASE NOTE: some letters may be edited for space.

PERSONAL FINANCES

the same stability. I have used
Arch-based distros like Manjaro
and KaOS, Debian-based distros,
e: personal finance
applications: For years, I have and RPM-based distros, but they
all let me down at some time or
always used Gnucash for all my
banking needs. It allows you to go other. Almost in desperation, I am
to your banking and "download to now using Kubuntu 1 5.1 0, which
Quicken" which will download bank seems pretty stable and gives me
all the apps that I require, plus
debits/credits to your Gnucash
enough customisation to get my
account. Setup is not difficult.
screen looking the way I want it.
You can print reports for assets
It seems that Ubuntu-based
and liabilities, budget, business
distros
are still the best and most
reports, income expenses and
reliable Linux distros.
more.

R

Bernie Victor

Tom
Ronnie says: Tom has kindly written

up a quick intro to Gnucash that will
be featuredin a future issue ofFCM.
Stay tuned!

D ISTRO H OPPING

I

M ULTIBOOT WITH UEFI

I

read this excellent article by
Frank Dennisen in FCM#1 02, but
would like to add one word of
warning, based on my own
experience.

have been using Linux for many
years, starting with Mandrake
Frank advises to run fstrim
over 1 5 years ago. Now I use Linux
Mint Cinnamon as my main distro, during boot-up by editing
but have been trying to find a KDE- /etc/rc.local. I normally schedule
based distro which would give me fstrim with cron to a time when I
full circle magazine #1 03

know I will not be using the
machine.
I tried Frank's suggestion but
forgot fstrim was running next
time I rebooted. I then tried to
suspend and the computer ignored
this for a while and then went to a
black screen. I hit Enter and the
screen repainted and then
suspended ok. When I tried to
wake-up the machine, I got a
terminal with a lot of messages
about memory locations being
unusable. A reboot fixed the
problem.
Frank's suggestion will work ok
but I think it is necessary to let
fstrim finish before creating any
disk activity. Unfortunately there is
no indication of when it finishes
and it can take some time; six
minutes in my case.

Michael

Join us on:
goo.gl/FRTMl

facebook.com/fullcircle
magazine
twitter.com/#!/fullcirclemag
linkedin.com/company/fullcircle-magazine
ubuntuforums.org/forum
display.php?f=270

FULL CIRCLE N EEDS YOU !
Without reader input
Full Circle would be an
empty PDF file (which I don't
think many people would find
particularly interesting). We
are always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.
See the article Writing for Full
Circle in this issue to read our
basic guidelines.
Have a look at the last page of
any issue to get the details of
where to send your
contributions.
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I N T E RV I E W W I T H

eBu yer

Conducted by Ronnie Tucker

FCM: If I may be so bold as to ask: in-house tech support teams have
how many Ubuntu PCs and
been trained to help on a wide
laptops have you sold?
range of common issues which are
eBuyer: Sorry, I can’t give out
direct sales data, but we are
delighted with the uptake of
Ubuntu and its sales as it has
exceeded our initial predictions.

Linux specific.

down to working on a good price
and partner… watch this space.

we stock will likely come as a
standard pre-install.

Do you ship to the USA/Canada,
or outside of the UK/Europe?

Why do some machines (laptops?)
seem to come with Ubuntu 1 2.04?

Unfortunately not at the moment,
Would you consider selling
Ubuntu phones (from BQ/Meizu)? we deliver to only the UK.

The strong figures have meant
we can plan ahead to next year,
opening up for more
manufacturers.

We have been looking at the
options for importing an Ubuntu
phone into the UK, we just need to
find the right distributor and price
structure.

How many (in
number/percentage) were
returned?

We’ve already had a lot of
interest in the BQ model from a
number of customers, so it’s now

I notice most desktop PCs come
with a DVD. Can I ask why Ubuntu
isn't pre-installed?
Ubuntu is pre-installed on all the
laptops we stock. However due to
the current manufacturers we use
for the desktops, it comes as a
simple DVD install. The next batch

Again can’t hand out sales data but
our returns have been marginally
lower on Ubuntu Laptops
compared to the Window 8
equivalent in 201 5.

Do you provide support for your
Ubuntu machines, or do you point
your buyers elsewhere for help?
The manufacturers (HP for the
current range of laptops) cover the
main support issues, however our
full circle magazine #1 03
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Ubuntu 1 2.04 was simply the stock
OS on the batch of HP G3 laptops
we brought in. However, most
people upgrade to the latest
edition of Ubuntu or sometimes
shift across to a different distro
like Mint.

What gave you the idea to start
using Ubuntu?
We used to sell a lot of products
with no operating system on
board, so we looked into why and
found that there was a massive
community for Linux systems,
specifically Ubuntu. From that, we
wanted to make it easier for
customers, so we created a line of
pre-installed models that we
hoped would take off, and it did –
as hardly any retailers in the UK
offer Ubuntu pre-installed.

Do you have a favourite flavour
of Ubuntu?
contents ^

INTERVIEW WITH EBUYER
Personally, I prefer the standard
Ubuntu package as it feels closer
to a traditional OS – but with the
Linux freedom, I’m a bit of newbie
in the Linux world, so it helps
having something that is tangible
to my old OS habits.
From our customer’s
standpoint, we’ve actually had a
lot of comment and questions
about Lubuntu due to its
lightweight nature and speed. I’d
be inclined to say that Lubuntu will
do well over the coming year.

Where do most Ubuntu buyers
come from?

(comparatively). If, like we hope,
Ubuntu sales pick up across a
number of lines, we’d love to add
more support.

Do you plan on having more
powerful Ubuntu machines
available? Or would you do, say, a
Lubuntu/Xubuntu range of
machines?

Have you had any hardware
challenges in putting together an The next batch of Ubuntu-installed
machines will likely be the next
Ubuntu PC/laptop?
Some manufactures have very
strong ties with Microsoft, as you
can imagine, so it’s sometimes
tough to get Ubuntu pre-installed.
However, the companies we have
spoken to about future ventures
have been very open after seeing
the uptake we had.

generation, so yes they will be
more powerful.

The overriding feedback on our
first stock of Ubuntu (in 201 4) was
“great to see Ubuntu, but we need
a more powerful laptop”. So, in
201 5 we came in with a more
aggressive processor and higher
RAM. We’ll likely try and make the

A big proportion are IT buyers, as
you can imagine, as well as a
number of enthusiasts. Next to
that, and possibly more
surprisingly, a number of the older
generation seem to look at Ubuntu
– we think because of the costing
and the easy-to-use nature of the
OS.

same jump this time – it just
depends on the manufacturer
supplying the units.
I don’t think we will move to
Lubuntu/Xubuntu just yet; Ubuntu
still has a long way to go, when it
comes to popularity with a wider
audience.

How about custom configurations
with Ubuntu?
We don’t really look to do custom
modification of any machines, so
it’s unlikely we would do it for
Ubuntu.

Do you use Ubuntu/Linux in the
Ebuyer offices?
We’ve got quite a range of OSes
here in the office. Our IT dev team
are the biggest consumers. As you
can imagine, they use a mixture of
Linux distros, the most popular are
Mint, Ubuntu and Debian.
Marketing also has a couple of
Ubuntu machines, but the rest of
the company is Windows-based.

Do you need to give more, or less,
support to Ubuntu buyers?

eBuyer: http://www.ebuyer.com

It’s difficult to manage in terms of
support because, currently, the
pool of customers is still small
full circle magazine #1 03
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Q &A

If you have a Linux question, email it to: misc@fullcirclemagazine.org , and
Gord will answer them in a future issue. Please include as much
information as you can about your query.

Compiled by Gord Campbell

space on the drive to create a
partition and install to it.

Q

During boot up, I got this
error message:

USB 2/3 device descriptor
read64, error -110

I am in the process of
Q installing
Ubuntu but the

entire HDD is filled with partitions.
Is there any way to figure out
which partitions can safely be
deleted? I've included a screen
capture (above) of the partitions.

A

(Thanks to SeijiSensei in the
Ubuntu Forums) Rather than
deleting partitions, I'd use the
Windows disk manager (Control
Panel > Computer Management >
Disk Management) to shrink the
Windows partition then give the
newly freed space to Linux during
installation.

I want to limit how much
Q Internet
bandwidth any one
user can have.

A

(Thanks to matt_symes in the
Ubuntu Forums) You can do
traffic shaping with the command:
tc

It was repeated two more
You'll want to read the man
times, then there were some other
page and look at tutorials on the
error messages.
net as it's a big area.
This sounds crazy, but it
works. Shutdown your
TOP QUESTIONS AT
I am very, very eager to install computer, unplug it for five
minutes, then plug it back in and
ASKUBUNTU
Tails but I would like to keep
start
it
up.
my current Ubuntu 1 5.1 0 +
* How important is the sudo
Windows 1 0 dual-boot config. Is it
My
vortexbox
server
is
password?
possible to triple boot with Tails?
unreachable. Its IP address is
http://goo.gl/8NxLe6
1
92.1
68.1
.255
(Thanks to DK1993 and
* How to create a bootable .iso file
Bucky Ball in the Ubuntu
(Thanks
to
SeijiSensei
in
the
from Ubuntu Live USB?
Forums) Tails is supposed to be
Ubuntu
Forums)
http://goo.gl/FRsgmu
used in a live environment. It is
1
92.1
68.1
.255
is
the
"broadcast"
supposed to run in RAM and delete
* Delete all files except specified
all information when the computer address for the 1 92.1 68.1 .0/24
network.
Both
1
92.1
68.1
.0
and
files/folders using command-line?
is powered down. Otherwise,
1
92.1
68.1
.255
cannot
be
assigned
http://goo.gl/S1 LCVG
considering distros that are
to
hosts.
Give
the
server
a
intended for installation on a hard
different address.
* Get all image files with wget
drive, yes, you can triple-boot
http://goo.gl/OVLx4n
without issue. You just need free

A

Q

Q

A

A
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Q&A
* Reinstall base Ubuntu without
formatting or removing manually
installed packages
http://goo.gl/RSQWrb
* Will Ubuntu 1 6.04 LTS server still
use dpkg?
http://goo.gl/mON1 J4
* Is Linux getting less or more
secure?
http://goo.gl/EOAUc6
* 1 5.04 is available to update to.
Will I lose my data?
http://goo.gl/8Iz4w2
* No version of Ubuntu can be
installed with any 6th generation
Intel processor
http://goo.gl/NXEXaR

computational. Even playing a
Youtube video was enough to
cause a problem.

In my specific case, it worked
beautifully. My CPU now idles at
the same temperature as me, and
even when rendering video, gets
I could tell this, because Conky, nowhere close to "too hot." Once
combined with lm-sensors and hdd- again, I have a "high-performance"
temp, displays all the
computer.
temperatures all the time. The
computer has a "production"
Aside: in my test partition, I
partition and a "test" partition, and upgraded Xubuntu 1 5.04 to 1 5.1 0,
they each have Conky installed to
and it went flawlessly. That's
tell me what I want to know.
where I am writing this column.
Eventually, I broke down and
addressed the problem. Open the
case, take the CPU heatsink and
fan out, and give them a good
cleaning. I also noticed that the
"thermal paste," which connects
the CPU to the heat sink, had
broken down. New thermal paste,
install the heatsink and fan again,
button up the case, and all is well.

This is not a job for the faint-ofheart! If you are concerned about
tackling it, take your computer to a
trusted tech, and be prepared to
pay a reasonable service fee. $1 00
his has little to do with Linux,
but I hope it's still interesting. is not too much. Why? Because
even the most competent service
My "high-performance desktop" person will occasionally have a slip
of the fingers, and now we're
computer is several years old. In
recent months, it has overheated if talking a new motherboard, CPU
and memory. Not cheap.
asked to do anything mildly

TIPS AND TECHNIQUES
CLEANUP!

T
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Gord had a long career in the

computer industry, then retired for
several years. More recently, he
somehow found himself "The IT Guy"
at a 1 5-person accounting firm in
downtown Toronto.
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S e c u ri t y

Q R Co d e s

Written by Alan Ward

Response” codes are
Q Rfast“Quick
becoming a popular

means of communicating snippets
of information from a printed
medium or other physical surface
towards computers and mobile
devices. They were originally
developed as a replacement for
the single-dimension bar code by a
team from the automotive
equipment design and
manufacturing company Nippon
Denso Co. Ltd.. The increase in the
amount of different car parts
handled gave rise to a desire to
augment correspondingly the
amount of data that could be
stored on the printed labels that
were used to identify the boxes in
storage and during transport.
Since 2006, the working
principles have become the ISO/IEC
standard 1 8004:2006, and so can
be seen as a recognized industry
technique. The team behind this
design (Masahiro Hara, Motoaki
Watabe, Tadao Nojiri, Takayuki
Nagaya, and Yuji Uchiyama ) won
the European Patent Office 201 4
Popular Prize for their efforts
(http://www.epo.org/learning-

events/europeaninventor/finalists/201 4/hara.html).
Nowadays, QR codes are widely
used in situations in which it is
desirable to present printed
matter containing links to
electronic information, in a way
that is easy for a computer to read
in. Examples include applications
such as a bus-stop transportation
map that includes a QR-encoded
link to the company’s web page to
get up-to-date information on
scheduling, a poster for a music
festival with a QR-enabled link to
the online ticketing service, or
train or aircraft tickets with QR
codes that are read at the entrance
stile to enable access to boarding.

qr-cup-0). The idea refers to a
Guinness beer glass with a printed
QR code, that is readable only
when the glass is still full of the
black stuff: only the white dots are
actually printed, while the black
dots are the beer itself showing
through from behind.
In this article, we will see how
to read and create QR codes in an
Ubuntu system using various
programs. Before continuing, it
should be noted that several other
similar systems can be found, such
as Data Matrix barcodes
(https://en.wikipedia.org/wiki/Dat
a_Matrix) and Aztec codes
(https://en.wikipedia.org/wiki/Azte
c_Code). Though each of these
systems is popular in places, QR
codes seem, for the time being, to
be the best supported, both by
Ubuntu and applications on mobile
devices.

At the same time, the folks in
graphics design have been making
use of the fact that data is actually
redundant inside the code; the
image can be modified in various
ways and still convey useful
THE ANATOMY OF A
information to the reader. A recent
QR CODE
example from 201 4 is the
“Guinness QR cup” by BBDO New
Let us consider a specific
York that has won a Caples award
(http://www.caples.org/guinness- example:
full circle magazine #1 03
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As can be seen, a QR code is in
fact a two-dimensional square
matrix of dots (pixels), that, in
essence, are binary zeros and ones.
This is in fact about the only time a
modern user of computing
equipment will have the chance to
get intimate with binary code since
it is often obscured by the various
layers of software in between.
When a QR code reader is
placed before this image, the first
parts that are detected are the
three positioning marks
emphasised in gold. These give the
camera a basic idea of the position
of the the QR code, as well as its
orientation. The small mark in red
also helps understand alignment;
contents ^
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there is only one of these on small
QR codes, but larger codes use a
repeating pattern to ensure
coherence across the width and
height of the image.

correctly detected), and motion
blur if the camera is not held
perfectly still at the time.

Error correction in QR codes
uses a branch of Reed-Solomon
QR codes may be of varying
error-correcting codes. With a bit
widths, expressed in the number
of (perhaps over-) simplification,
of dots used. However, this has
these codes can be seen as
nothing to do with the actual
basically repeating all information
physical size of the image, nor to
more than once. Redundancy is
the resolution of the photograph
calculated in such a way that not
the reader has taken of it. So the
only can errors be detected, but
second stage in code
also corrected upon reading. With
interpretation is to figure out how sufficient extra bits added to each
many dots are being used in this
data word, more than one single
particular code. To do this, a simple error can be detected - unlike more
repeating pattern of black and
simple schemes in which two
white dots is placed between the
errors in the same word could go
orientation marks (shown in
undetected.
green). This “timing” pattern is
easy for the reader to interpret,
Nowadays, the details of how
and so figure out the number of
the error detection and correction
lines and columns in the mesh.
are handled go quite under the
radar of the human user. Software
The rest of the dots correspond (on most consumer-grade devices)
to a mix of QR code version
or hardware (in industrial
information, format information,
applications) take care of this part
the actual data, and error
and simply give us the decoded
correction codes. Error correction information in readable form.
is necessary, since cameras do not
always give a clear image of the
In fact, the addition of
code area (due to the presence of superimposed colors to the QR
dust, scratches on the lens, etc.),
code above has not made it
interpretation may also get some
unreadable - if you have a QR
dots wrong (if colors are not
reader or application available, go
full circle magazine #1 03

ahead and see what it says!

SOME SOFTWARE
There is in fact a selection of
software available in the Ubuntu
repositories to create QR codes.
One of the most basic is qrencode
from the apt package with the
same name. This is a console-only
program. For example, to encode
the web page address of our
favorite magazine, simply issue:
qrencode -o qr-example1.png
http://fullcirclemagazine.org

This creates the image qrexample1 .png in the current
directory:

The same program can also
create QR codes in a variety of
formats. One of particular interest
is SVG. The corresponding
command would be:
qrencode -o qr-example1.svg
-t SVG
http://fullcirclemagazine.org
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In the other direction, the zbartools package contains programs
to handle converting a QR code
read in from the camera (zbarcam)
or from an image file (zbarimg).
For instance:
zbarimg qr-example1.png
QRCode:http://fullcirclemagazin
e.org/
scanned 1 barcode symbols
from 1 images in 0.02 seconds

On the graphical side of things,
perhaps the best known
application for Ubuntu is QtQr.
Using the Qt library on which the
KDE desktop is based, this
program also works quite well
under other desktop managers,
being sufficiently integrated to
include dragging files to and fro.
The software contains a
complete QR code generator,
where the user can not only
specify the type of information to
be encoded (URLs, but also other
structured information such as
personal contact information,
georeference or even WiFi
network details), but also the dot
size in pixels, margin width and
level of data redundancy to be
contents ^
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used.
QtQr reads in QR codes either
from image files, or by accessing
the computer’s webcam if
available. This is handy to read in
data from a mobile phone, without
needing to set up wireless
communication (Bluetooth or
similar).

EDITING QR CODES
Once a QR code has been
created, some editing can take
place without altering the
information contained within. To
take an example, I will take the
“http://fullcirclemagazine.org” QR
above, in SVG form. As line-art, it
can then be imported into a vector

then choose Object > Fill and
Stroke in the menu. We can play
around with the fill color, and add
blur for artistic effect.

contrasted with the background.
Some experimentation may be
needed for good results.

In Inkscape, photographs may
be used as patterns to fill in areas.
The image (JPG, PNG or similar) is
imported, then converted into a
pattern using menu option Object
> Pattern > Objects to Pattern. The
black markings in the QR code are
QR codes are sufficiently robust then selected, and filled with the
that even relatively light colors can new pattern. As before, it is best to
be used, and still function as a
use images with similar and rather
editing program such as Inkscape
code. However, one should not try dark colors - and no very lightand modified to suit our needs.
to go too far - ‘too far’ being colors colored spots in them (if using a
Opening it with Inkscape, the first with little contrast to the
white background).
thing we notice is that the white
background, or a combination of
background has been grouped
light and dark colors. These do not
together with the black markings. work well with most QR readers. If
We can select the complete
we do stay within these
assembly and hit Ctrl-Shift-G to
parameters, some effects such as
ungroup them.
gradients are possible. To apply
these, select the markings, and in
The black markings themselves the Fill dialog choose Gradient fill.
On the other hand, very light
are also individual rectangles that You will need to edit the gradient images can be used to color the
have been grouped together. If we end-points to make sure that both markings, on top of a dark
wish to alter individual pieces, they of the colors used to build the
background. Alternatively, a single
will also need to be ungrouped
gradient are sufficiently
color can be used for the markings,
first. For our examples, however,
which are then placed on top of
we will keep them together in one
the image. As long as there is
piece.
enough contrast for the QR reader
to detect the markings correctly,
The first thing we can do with
just about any combination can be
the black markings is to change
tried out.
their color. Select the markings,
full circle magazine #1 03
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This is about as far as one can
go with this low-redundancy level
QR code. However, if a high level
of redundancy has been specified
when creating the code, large
areas of dots can be covered up
with other graphical information.
Although this will give some errors
on reading, the error-correction
codes used will still enable the
reader to establish the original
message. There are some areas of
the code that must not be
touched. As described in the
previous section, positioning,
alignment and timing marks are
necessary for good operation.

Altering version information is
probably not a good idea either.
But if we stick to the central part

of the code, we can take some
liberties without going too much
into the danger zone:
For further ideas on how to use
Inkscape, Mark Crutch’s ongoing
series in FCM is probably the place
to start - try the Special Edition
Volume 1
(http://fullcirclemagazine.org/inksc
ape-special-edition-volume-one/),
specifically Part 5 for details on
how to fill regions.

human error. They always carry the
darn things around with them, so
we might as well make good use of
them, right?

A second use of QR codes is to
pass
along short quotations from
COLOPHON
texts. QR codes are well able to
I would like to end with a couple hold several paragraphs of text,
of practical use-cases that go a bit about what would be useful for a
single study period. So, for
further than adding dynamic
content to commercial posters. In example, Cicero’s classical
discourse against Catalina could be
my day job as a teacher, I often
give students pointers on where to studied in extract form. The
original text goes:
obtain further information, if
necessary, on the topic being
“Quo usque tandem abutere,
studied. For some time now, I have
Catilina, patientia nostra?Quam diu
been projecting slides with the
etiam furoriste tuus nos eludet?
relevant URLs. However, even
when using shortened URLs (“tiny” Quem adfinem sese effrenata
URLs), copying mistakes are made iactabit audacia?Nihilne te
all too often. Including the relevant nocturnum praesidium Palati, nihil
URLs in QR form makes it possible urbis vigiliae, nihil timorpopuli, nihil
concursus bonorum omnium, nihil
for students to come up to the
screen and “shoot” the codes with hic munitissimus habendisenatus
locus, nihil horum ora voltusque
their mobile phones - thus
moverunt?Patere tua consilia non
acquiring the link without any
full circle magazine #1 03
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omnium scientia teneri
coniurationem tuam non vides?Quid
proxima, quidsuperiore nocte egeris,
ubifueris, quos convocaveris, quid
consiliiceperis, quem nostrum
ignorare arbitraris?O tempora, o
mores!”
Transformed into a slide for
presentation to the class, once
scanned, the QR code would then
appear as shown (on the student’s
tablet):

The text can then be sent off to
Google Drive or a note-taking
application, and -one hopes- also
be worked on.
As a side note, we can see
through this example that QR
codes are system-agnostic, and
thus a good way of passing
information between operating
systems - even though some of
them may be rather less open than
Ubuntu.
contents ^
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Written by S. J. Webb

As the 1 960’s developed, Bell
Labs grew. Ali Javan developed
and operated the first gas laser.
Metal oxide semiconductor and
integrated circuits laid the
groundwork for our current info
society. Soon a carbon laser was
developed. Unix was born in 1 969.
Aaron March was the first graphic
designer to create a barebone GUI
for computer systems.

which was used to rewrite part of
Unix. Fiber Optic cables were
developed and tested in Atlanta,
Georgia. The first 32 bit
microprocessor was developed.
Numerous other telephony devices
were created. Bell Labs
undoubtedly was a mecca of
technology genius in this time
frame.
However this time frame ended

in 1 984. The U.S. federal
government broke up ATT due to
its sheer monopoly on phone lines.
This lead to Western Electric
becoming the sole owner of Bell
Labs. Western Electric was now
called ATT Tech.

was slow but steady growth in
developing new technology. In
1 996 ATT Tech changed its name to
Lucent Technology. Under the new
name the first organic laser was
developed and plastic transistors.
In 2006 Lucent Technology and
Alcatel merged under the name of
Plan 9 (shown below) was a new Bell Labs.
OS meant to replace Unix in 1 985.
Later on the Inferno OS was
This merger led to downsizing.
developed to refine Plan 9. There
The research center will only begin
to start focus on profit centers.
Therefore in 2008 emphasis was
given to network development,
high speed electronics, nanotech,
and software. The lab lost its sense
of direction due to goals of profit.
In 201 3 the lab realigned itself to
its earlier roots of information and
communication technology.
In April of 201 5 Nokia bought
the parent company of Bell Labs,
and by default Nokia acquired the
sleeping giant of technology.
Hopefully Nokia will help lead Bell
Labs down the path of awe again.

These quick changes led to the
1 970s’. Dennis Ritchie (above)
compiled the C computer language
full circle magazine #1 03
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Sh a d ow O f M ord or

Written by Oscar Rivera

O

ne game to rule them all!
Tolkien's Middle Earth is a
vast insatiable world of fantasy
and adventure. Most people today
are familiar with The Hobbit and
the Lord of the Rings trilogy, but,
somewhere in between, there is a
new adventure that has recently
been released as a video game.
Best described as a single-player,
third-person, open-world, actionadventure RPG, Middle Earth:
Shadow of Mordor takes place in
the time period after Tolkien's The
Hobbit, but before The Lord of the
Rings trilogy.

websites nominating and/or
electing it as Game of the Year. The
list of accolades includes GDC
Game of the Year, Gamespot's
Game of the Year, and gamesradar
Game of the Year – to name just a
few. Gaming on Linux claimed that
it was a “rare (Linux)... high-quality
open-world game... which had
delivered something special.”

After reading so many rave
reviews, I couldn't help but buy it
so I could decide for myself
whether this game was worth
everything critics claimed it was. I
was not the least bit disappointed.
Developed by Monolith
Productions, published by Warner
Brothers Interactive
Entertainment, and ported to

In September 201 4, Middle
Earth: Shadow of Mordor was first
released for PC, PS4 & Xbox One.
Subsequently, it was also released
for PS3 & Xbox 360 later that year.
Most recently, in July 201 5,
Shadow of Mordor was released
for Linux. Immediately following its
Linux release, word began to
spread around the Linux
community that this game was a
must-have. Shadow of Mordor
began to appear in just about
every list of top-ten must-have new
releases with many publications &
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Linux by Feral Interactive, Middle
Earth: Shadow of Mordor gets my
vote for Linux Game of the Year. It
was rather difficult for me to put
the game down in order to write
this review; that's how good the
game is.
To play the game, you can
download it from Steam or Humble
Bundle for the current regular
price of $49.99 unless you happen
to catch a sale anytime in the near
future which is not out of the
question. Once installed, you're
ready to play. Shadow of Mordor
has been described as a cross
between the Assassin's Creed and
the Arkham Batman series of
games. Having previously played
games from both of those series, I
can testify that such claims are
accurate. Anyone who has played
any of the Assassin's Creed or
Arkham Batman games will feel
right at home playing Shadow of
Mordor. However, Middle Earth:
Shadow of Mordor goes above &
beyond anything else ever
developed as it has been injected &
infused with enough creativity &
innovation to stand on its own as a
contents ^
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uniquely phenomenal game that
no gamer should do without.

combat skills that enhance his
three primary fighting styles via
the use of runes and learned
As the game begins, Talion (the abilities. When you kill enemies,
main character), witnesses his
especially chiefs & captains, Talion
family being murdered by coldearns points and runes, but it is up
blooded Orc warriors fighting for
to you to decide which abilities will
the Black Hand of Sauron. As the
be mastered – which is what gives
opening sequence plays out, Talion the game its RPG element. There
himself is murdered by these
are two sides to Talion, the regular
savage Orcs but his soul is unable
human side and the wraith-like side
to join his family in the afterlife. As – which are both upgradeable
he is savagely murdered, Talion
depending on your playing style.
somehow merges with an Elf
You control Talion either through
Wraith who is also out for revenge mouse/keyboard or a game
against the Black Hand of Sauron. controller, both of which work very
Having been magically united,
Talion and the Wraith embark on a
dark journey that will take them
through Mordor as they kill Orcs,
Uruks, chiefs, captains and all sorts
of beasts, animals & monsters on
their quest to exterminate the
Black Hand of Sauron and anyone
who gets in their way. Along the
way, Talion also co-operates with
other characters such as Ratbag,
the Uruk who Talion helps become
war-chief, and we even work
alongside Gollum who is dying to
obtain his “precious ring.”
Talion can engage in melee,
ranged & stealth combat at the
outset of the game. As the story
unfolds, Talion acquires other
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well on this game; the choice is
yours. What really sets this game
apart from anything that has ever
gone before, is what's been
referred to as the Nemesis system.
Basically, when an opposing enemy
kills you in this game, not only do
you die and have to re-spawn at a
predetermined forge tower, but
the character who killed you, and
any other allies who might have
been with him when you died, will
level up (ie, increase their level
number) and use your death to
their advantage. The way in which
the developers incorporated this
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concept into the game is truly
fascinating. The Nemesis system is
dynamically creating a living
Mordor which breathes and
pulsates according to your actions
– thus presenting you a soon-to-be
wasteland tailor made for you.... by
you.
For example, there was a
captain in the first half of the game
who I couldn't defeat – no matter
how hard I tried. When I first
encountered him, he was a level 1 3
at a time when I was just getting
comfortable at fighting against
level 8 enemies. With each death I
suffered against him, not only
would he level up, but also his
strengths would increase while his
weaknesses decreased. Eventually,
he was so powerful (lvl 1 8) that I
opted to avoid him at all cost until I
felt I was powerful enough to bring
him to his knees. When I finally
chopped off his head, he had risen
to level 20 and just before my
sword sliced through his neck he
even said something like “at long
last you've defeated me.” I couldn't
help but laugh at his comment and
marvel with a dropped jaw at how
this particular captain who I had
helped turn into an unbeatable
foe, even remembered my playing
style and how many times he'd
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killed me, among other things. If I
call the Nemesis system genius, I'm
still short of giving it the credit it
deserves. I wouldn't doubt to find
influences of the Nemesis system
in future games still to come.

still work fairly well on very low
that's the game's well deserved
settings. It would be a shame if
rating as it is rather graphically
support for AMD & Intel didn't
violent.
come soon. I had to contact Feral
Interactive regarding compatibility
problems I had while playing this
game with Valve's new Steam
On my system, Shadow of
Controller, and they promptly
Mordor had very few glitches, if
replied and gave me some valuable M INIMUM REQUIREMENTS :
any at all. A couple of times I had
Rather than continue talking
advice.
to re-start the game with lower
about all of the things I've enjoyed
OS: Ubuntu 1 4.04.2 64-bit /
default settings, but I'll be the first about this game, it's best I say that
Feral Interactive has done a
SteamOS
to admit that these were not so
I've seriously been thinking about superb job in bringing this title to
Processor: Intel Core i5-750, 2.67
much bugs, but rather me trying to any negative aspects of the game
Linux and I cannot think of a better GHz | AMD Phenom II X4 965, 3.4
push my system beyond its limits.
and cannot come up with anything way to thank them other than
GHz
The game isn't to blame. The
I dislike about it. Although I'm not buying Shadow of Mordor. I give
Memory: 4 GB RAM
graphics on the game are not next affected by it, I must unfortunately the game a solid rating and
Graphics: 1 GB NVIDIA 640 or
generation but the fluidity with
report that Intel & AMD graphics
strongly recommend it to
better with driver version 352.21
which the visuals move in & out of are not yet supported, but I
everyone.... or rather to all Mature or later
battle, especially during combatunderstand that the game should
Audiences who are age 1 8+ since
Network: Broadband Internet
finishing moves, are very pleasing
connection
to the eye. The voice acting is
Hard Drive: 47 GB available space
another in a long list of strengths.
Additional Notes: AMD and Intel
Shadow of Mordor also comes with
cards are NOT supported.
a benchmark which you can run to
test your system. If you are
interested in taking screenshots of
the game, there's even a feature
that can be enabled/disabled
which can potentially turn you into
a real visionary screenshot
Oscar graduated from CSUN, is a
publishing artist.
Music Director/Teacher, beta tester,
If enabled, the game can be
paused at will and a wide array of
tools appear before you to alter

the paused screenshot and turn it
into a visual masterpiece. You can
completely change the angle, add a
border, focus in/out of it, get up
close or far back, change the
“canvas” as it were, make it black &
white, sepia, etc. It's a feature I
found quite useful.

Wikipedia editor, and Ubuntu
Forums contributor. You can contact
him via: www.gplus.to/7bluehand or
email: 7bluehand@gmail.com
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CHA CHA CHA CHANGES
Our admin went AWOL for months, and
I had no idea if/when the site
would/wouldn’t get paid. Initially the
plan was to move the site and domain
name to my hosting, but eventually I
managed to track him down and get
the FCM domain name, and site hosting
transferred to me.
The new site is now up. HUGE thanks to
Lucas Westermann (Mr. Command &
Conquer) for taking on the job of
completely rebuilding the site, and
scripts, from scratch, in his own time.
The Patreon page that I’ve set up is to
help me pay the domain and hosting
fees. The yearly target was quickly
reached thanks to those listed on this
page. FCM is not going away. Don’t
worry about that.
Several people have asked for a PayPal
(single donation) option, so I’ve added
a button to the side of the site

A big thank you to all those who’ve
used Patreon and the PayPal button.
It’s a big help.

https://www.patreon.com/
fullcirclemagazine
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FULL CIRCLE NEEDS YOU!

A magazine isn't a magazine without articles and Full Circle is no
exception. We need your opinions, desktops, stories, how-to's,
reviews, and anything else you want to tell your fellow *buntu users.
Send your articles to: articles@fullcirclemagazine.org

Deadline :

Sunday 05th Dec. 201 5.
Release :
Friday 25th Dec. 201 5.

We are always looking for new articles to include in Full Circle. For help and advice
please see the Official Full Circle Style Guide : http://url.fullcirclemagazine.org/75d471
Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our site via: fullcirclemagazine.org

Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org
Webmaster - Lucas Westermann
admin@fullcirclemagazine.org
Editing & Proofreading
Mike Kennedy, Gord Campbell, Robert
Orsino, Josh Hertel, Bert Jerred, Jim
Dyer and Emily Gonyer
Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

Getting Full Circle Magazine:

EPUB Format - Recent editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with
the epub file, you can drop an email to: mobile@fullcirclemagazine.org

Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to
spread the word about FCM and Ubuntu Linux.

Google Play - You can now read Full Circle on Google Play/Books. Either search for 'full circle magazine' or
click this link: https://play.google.com/store/books/author?id=Ronnie+Tucker
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